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1. In a nutshell

The development of heuristics implemented in robust application softwares has made large
phylogeny inference a key step in most comparative studies involving molecular sequences. The
choice of a phylogeny inference software is not only dictated by the raw performance (speed) of the
algorithm(s) and of its (their) implementation, the availability of complex substitution models, and
the accuracy of the resulting trees, but also by a combination of parameters pertaining to the ease-
of-use and the availability of specific functionalities.

Here, we present the manual of MetaPIGA, a robust implementation of several stochastic
heuristics for large phylogeny inference (under maximum likelihood), including a Random-Restart
Hill Climbing, a Stochastic Simulated Annealing (SSA) algorithm, a classical Genetic Algorithm
(GA), and the Metapopulation Genetic Algorithm (metaGA) together with complex substitution
models, discrete Gamma rate heterogeneity, and the possibility to partition data. MetaPIGA handles
nucleic-acid and protein datasets as well as morphological (presence/absence) data. The benefits of
the metaGA ([1] Lemmon & Milinkovitch 2002; PNAS, 99: 10516-10521) are as follows: (i) it
resolves the major problem inherent to classical Genetic Algorithms (i.e., the need to choose
between strong selection, hence, speed, and weak selection, hence, accuracy) by maintaining high
inter-population variation even under strong intra-population selection, and (ii) it generates branch
support values that approximate posterior probabilities.

The software MetaPIGA also implements:

v Simple dataset quality control (testing for identical sequences and excessively ambiguous or
excessively divergent sequences);

v Automated trimming of poorly aligned regions using the #rimAl algorithm [2];

v The Likelihood Ratio Test, Akaike Information Criterion, and Bayesian Information Criterion for
the easy selection of nucleotide and amino-acid substitution models that best fit the data;

v Ancestral-state reconstruction of all nodes in the tree;

v Codon models for the analysis of protein-coding nucleotide sequences;

v Faster Likelihood computation on Nvidia graphics cards;

v Automated stopping rules based on convergence statistics.

MetaPIGA provides high customization of heuristics’ and models’ parameters, manual batch file
and command line processing. However, it also offers an extensive and ergonomic graphical user
interface and functionalities assisting the user for dataset quality testing, parameters setting,
generating and running batch files, following run progress, and manipulating result trees.

MetaPIGA uses standard formats for data sets and trees, is platform independent, runs in 32-
and 64-bits systems, and takes advantage of multiprocessor and/or multicore computers. Note
that MetaPIGA allows the use of the XtremWeb-CH infrastructure for distribution of multiple jobs
on a Grid.

MetaPIGA is freely available to academics at www.metapiga.org and www.lanevol.org
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2. Background

Phylogeny inference allows, among others, detecting orthology/paralogy relationships among
gene-family members (e.g., [3-6]), estimating divergence times and evolutionary rates (e.g., [7-9]),
reconstructing ancestral sequences (e.g., [10-14]), identifying molecular characters constrained by
purifying selection or which experienced positive selection (e.g., [15]), uncovering hidden
biodiversity (e.g., [16]), and mapping the evolution of morphological, physiological,
epidemiological, biogeographical, and even behavioral characters [17, 18]. Molecular phylogeny
inference is now a mature science, and an important part of the maturation process pertained to the
realization (since the late 1990’s) that the quest for the Holy Grail of THE absolute best tree should
be abandoned for a much more meaningful goal: the inference of clades and trees robustness. Still,
this objective remained intractable in practice because of (a) the NP-hard nature of optimality-
criterion-based phylogeny inference (i.e., no algorithm can solve it in polynomial time; [19, 20])
and (b) the large computing-time requirements when using complex substitution models (and rate
heterogeneity across sites) in the framework of what has been identified as the probable most robust
optimality criterion: Maximum Likelihood (ML; [21-23]; See Appendix 3 for an introduction to
ML). Today large phylogeny inference is incorporated, across biological disciplines, as an essential
step in most comparative studies involving nucleotide or protein sequences. This has been made
possible thanks to both theoretical and practical developments.

First, one key advance that made large phylogeny inference tractable is the implementation in
this field of stochastic heuristics with inter-step optimization, i.e., a family of approaches that
existed for decades in physics and computer science and explore multidimensional solution spaces
in a much more efficient manner than the older intra-step optimization hill-climbing methods.
Indeed, in the latter, one prime parameter (typically, the topology of the tree) is modified and all
other parameters are optimized before the new solution is evaluated whereas, in stochastic
heuristics, all free parameters are optimized while the search proceeds. Inter-step optimization
methods include Markov Chain Monte Carlo (MCMC) approximations of the Bayesian approach
[24, 25], stochastic simulated annealing [26], and genetic algorithms [1, 27-30]. The efficiency of
stochastic heuristics is quite counterintuitive but can be explained by several factors: (a) poorer
solutions are accepted with a non-null probability (contrary to hill-climbing that strictly restricts
moves toward better likelihood values) such that valleys in likelihood space can eventually be
crossed; and (b), parameters are not over-optimized (e.g., starting and intermediate trees are
generally largely sub-optimal, hence, optimizing model parameters on these trees is a clear example
of over-fitting). In addition, we think that avoiding over-optimization at every topology evaluation
generates a flatter likelihood-space shape, such that valleys are more easily crossed and local optima
more easily escaped. This suggestion however requires further investigation.

Second, several stochastic methods have been incorporated into robust application softwares.
The importance of that point should not be underestimated. For example, the success of Bayesian
methods is probably due as much to its incorporation into robust and efficient software (e.g.,
MrBayes; [31]) as to the theoretical appeal of generating marginal posterior probabilities [25]. The
software RaxML [32], enjoys deserved popularity because it is one of the fastest ML phylogeny
inference programs available to date (despite that it does not incorporate stochastic methods) thanks
to the implementation of approximations to rate heterogeneity across sites and smart computer
science tricks speeding up likelihood computation: optimized parallel code and ‘Subtree Equality
Vectors’ (i.e., the extension of character compression to the subtree level). Similarly, highly efficient
parallel code has recently been implemented for the evaluation of phylogenies on graphics
processing units (GPUs), resulting in 10 to 100-fold speed increase over an optimized CPU-based
computation [33]. This efficient use of new hardware, existing stochastic heuristics (in this case, an
MCMC approach in a Bayesian framework), and smart code parallelization for efficient harnessing
of the hundreds of GPU processing cores allowed the authors to use a 60-state codon model on a
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dataset of 62 complete mitochondrial genomes. Note that MetaPIGA now implements GPU
computation (since version 3.0b0).

The availability of multiple excellent softwares implementing different robust heuristics is
clearly an asset for the end user: reliable results might be identified because they remain stable
across softwares and methods. However, many users chose one single main software for their
analyses, and this choice is sometimes dictated by availability of functionalities of importance (e.g.,
batch analyses, GTR nucleotide substitution model [34] and rate heterogeneity [35-37], possibility
to partition data) but that do not pertain to the performances of the specific heuristic implemented.
Finally, given that the need to infer large trees is critical in multiple biological disciplines, the non-
specialist can be baffled by the large number of available heuristics, parameters, and softwares, such
that the most user-friendly tools are sometimes preferred even if more robust or more efficient (but
less user-friendly) softwares are available.

There is therefore a challenge to supply softwares that are both easy to use for the non-
specialist, provide flexibility for the specialist, and allow fast and robust inference for both. We
hope MetaPIGA version 3 provides a solution to this conundrum.

3. The metaGA algorithm & MetaPIGA

The Metapopulation Genetic Algorithm (MetaGA; [1]) is an evolutionary computation
heuristic in which several populations of trees exchange topological information which is used to
guide the Genetic Algorithm (GA) operators for much faster convergence. Despite the fact that the
metaGA had initially been implemented in a simple and unoptimized software (metaPIGA-v1)
together with simple nucleotide substitution models, an approximate rate heterogeneity method, and
only a low number of functionalities, it has been suggested as one of the most efficient heuristics
under the ML criterion. Furthermore, multiple metaGA searches provide an estimate of the posterior
probability distribution of trees [1].

The metaGA resolves the major question inherent to classical GA approaches: should
one use a soft or a stringent selection scheme? Indeed, strong selection produces good solu-
tions in a short computing time but tend to generate sub-optimal solutions around local op-
tima. Conversely, mild selection schemes considerably improve the probability to escape local
optima and find better solutions, but greatly increase computing time. As the metaGA involves
several parallel searches, initial inter-population variation can be very high (especially if ran-
dom or pseudo-random starting trees are used), and somewhat maintained during the search,
even under extreme intra-population selection.

Although the metaGA has been shown to perform very well [1, 38, 39] it initially did not im-
plement complex substitution models, discrete Gamma rate heterogeneity, and the possibility to par-
tition data. Here, we present MetaPIGA version 3, a program in which we performed such an im-
plementation, both for nucleotide and protein data, together with a hill climbing, a classical Genetic
Algorithm (GA), and a Stochastic Simulated Annealing (SSA) algorithm. MetaPIGA version 3 also
implements dataset quality control, automated trimming of poorly aligned regions, criteria (Likeli-
hood Ratio Test, Akaike Information Criterion, and Bayesian Information Criterion) for the easy
selection of nucleotide and amino-acid substitution models that best fit the data, ancestral-state re-
construction of nodes, Codon models for the analysis of protein-coding nucleotide sequences, faster
Likelihood computation on Nvidia graphics cards, and automated stopping rules based on conver-
gence statistics. MetaPIGA can also be parallelized on a Grid of computers.

MetaPIGA gives access both to high parameterization, as well as to an ergonomic interface
and functionalities assisting the user for sound inference of large phylogenetic trees.
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4. The software MetaPIGA
4.1. Availability

The software MetaPIGA is freely available to academics at www.metapiga.org , and is avail-
able for Windows, Mac OSX, and Linux. Note that, each time you launch MetaPIGA, it checks for
the availability of updates. MetaPIGA will always request your authorisation to perform such an
update. This manual is also available in the MetaPIGA help menu.

Disclaimer. MetaPIGA is provided without warranty of any kind. The authors and their institutions do not warrant guarantee, or
make any representation regarding the use or the results of the program or manual in terms of their correctness, reliability, or other-
wise. In no case will the authors and their respective institutions be liable for any direct, special, indirect, incidental, consequential,
or other damages arising from using the metaGA and/or any version of MetaPIGA and/or this manual and/or any supporting material.
MetaPIGA is freely available only to Academics. If you are working for a commercial company and are planning to use MetaPIGA,
please, contact michel.milinkovitch -at- unige.ch

4.2. Recommended citations

The Consensus Pruning (CP) and the Metapopulation Genetic Algorithm (metaGA) were
originally described in the first reference below, whereas the version 2 of MetaPIGA (the software
implementing the MetaGA and other heuristics) is described in the second. Hence, we would be
grateful if you could cite these two references when publishing results produced with MetaPIGA
version 3.

v Lemmon A R. & M. C. Milinkovitch
The metapopulation genetic algorithm: an efficient solution for the problem of large phylogeny
estimation
Proceedings of the National Academy of Sciences (PNAS), USA, 99: 10516-10521 (2002)

v Helaers R. & M. C. Milinkovitch
MetaPIGA v2.0: maximum likelihood large phylogeny estimation using the metapopulation genetic
algorithm and other stochastic heuristics
BMC Bioinformatics 2010, 11: 379

4.3. CPU, GPU, Operating Systems, and memory requirements

CPU & Operating Systems. As optimality-criterion phylogeny inference in general, and ML
inference in particular, is a computer intensive endeavour, fast CPUs are always preferable, even
when using powerful heuristics such as MC? or the metaGA. Using a ranid frog dataset (provided
with the software as one of the example datasets) of 64 taxa X 1976 nucleotides each, a typical
metaGA run (4 populations of 4 individuals, and default parameter values) will take approximately
2 minutes to complete under a simple model (Jukes-Cantor) and about 20 minutes under a complex
model (GTR + gamma distributed rate heterogeneity) on a single core of a 2.27 GHz Intel Xeon
processor (you can easily reduce running time by distributing replicates on several cores, see be-
low). Hence, when using datasets of over 100 taxa and when performing replicates (to estimate pos-
terior probabilities of clades; see below), you should expect runs to last several hours. If you are
experienced in the use of MrBayes [31], take as a rule of thumb that a thorough analysis using the
MetaGA requires a running time similar to that of using MrBayes with the same dataset.

MetaPIGA is written in Java 1.6 such that the single code runs on 32 and 64-bits platforms
under MacOS X, Linux, and Windows. We use the Java Multi-Threading technology to take advan-
tage of multiprocessor and/or multicore computers, such that some tasks can be run in parallel. As
replicates are independent, they are particularly prone to parallelization: different replicates can be
assigned to any number of different processor cores (typically 4 - 12 in most 2013 machines). In
addition, the metaGA heuristic itself is well suited to parallel implementation because many proc-
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esses (mutations, selection, and likelihood computation) are independent across populations. Hence,
different metaGA populations can be distributed to different processor cores. Parallelization of
metaGA populations can be combined with parallelization of replicates (e.g., 16 cores allow run-
ning simultaneously 4 metaGA replicates with 4 populations treated simultaneously at each repli-
cate). Note that distributing different replicates to different cores is more efficient (in terms of com-
putation speed-up) than distributing different populations to different cores'. Hence, parallelization
of populations usually increases running speed by about 0.3n whereas parallelization of replicates
increases running speed by almost n (where n= the number of CPU cores you assigned to
MetaPIGA).

Computing on GPU (Graphics cards). Analyses of protein or codon datasets are particu-
larly long because of the high number of possible state substitutions (20x20 for amino-acid data;
64x64 for Codon data). In such cases, performance can be substantially increased if likelihood
computation is performed on GPUs (Graphics processing units), also called ‘Graphics cards’. These
are devices that provide fine-grained parallelization. MetaPIGA version 3 can run on CUDA-
capable graphics cards from Nvidia Corporation. The graphics card’s compute capability has to be
at least 2.0. The list of CUDA-capable graphics cards can be found on the following web site:
https://developer.nvidia.com/cuda-gpus. Note that the performances of GPUs are low for nucleotide
sequence data, substantial for protein sequence data, and spectacular for codon sequence data.

In order to make use of the available supported graphics card, appropriate CUDA drivers have to be installed. The drivers
and the installation instructions can be found on the following web site:
https://developer.nvidia.com/cuda-toolkit-42-archive. Be sure to install the 4.2 Toolkit version and the drivers that come
with that version of the CUDA Toolkit. MetaPIGA v.3 hasn’t been tested on the newer versions of the CUDA Toolkit.

If you’re using a Linux distribution with graphics card, prior to launching MetaPIGA, you must set the environment vari-
able that points to the CUDA library, like this:

export LD PRELOAD={path to the CUDA library}:SLD PRELOAD

Where {path to the CUDA library} pointstothe '‘libcuda.so’ CUDA library.

For example on one of our machines this variable setting looks like this:
export LD PRELOAD=/usr/lib/nvidia-current/libcuda.so:$LD_ PRELOAD

For best performances, the graphics card must have enough built-in memory (see the ‘memory’
sections below).

The Grid. If you are a user of the XtremWeb-CH infrastructure, you can use a Grid to per-
form your data analysis with coarse grained parallelization. This means that different replicates are
computed on the different worker computers on the Grid. If you have 100 computers on your grid,

your analysis will be about 100 times faster.
In order to use the grid, first you have to have an account on the XWCH. After you make an account, you have to ask the
XtremWeb-CH support to connect a MetaPIGA module to your account. When the MetaPIGA module is ready, you have to
upload the MetaPIGA binaries to your MetaPIGA module. Provided with MetaPIGA is a small program that uploads these
binaries to the grid. This program is available in the MetaPIGA base folder on your computer in the subfolder
‘XWCH _bin_uploader’. You will have to provide the ‘MetaPIGA 3.jar’ that is in the base MetaPIGA folder, your user
identification number, the grid server address, and the MetaPIGA module ID. These informations can be found in your
XtremWeb-CH interface. If you can’t find them, consult with the XtremWeb-CH project people. Note that, every time
MetaPIGA is updated, you will have to upload the binaries again in order to have the latest version of the MetaPIGA on the
grid. For the user documentation, please, refer to the following web site:
http://www.xtremwebch.net/mediawiki/index.php/How_use

Memory. Computing and storing the likelithood of large trees require large amounts of
Random-Access Memory (RAM). Note that 32-bits systems can allocate a maximum of ~2Gb of
memory to the Java Virtual Machine (JVM), whereas 64-bits systems are limited only by the
amount of memory installed on the computer (the theoretical limit is 16 billions gigabytes). The

' Indeed, under CP, different populations of a single metaGA search must exchange topological information, hence, the
running time at each generation is limited by the population which is slowest to complete. On the other hand, different
replicates are totally independent.
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equation below allows calculating the number of Giga-bytes of free RAM (i.e., RAM that must be
available when your OS is running) you will need for using MetaPIGA:

T -N-D-C-S-P-4
RAM (Gb) = ~ ——
1024°

where 7 is the number of trees used at each generation, N is the number of nodes in the tree (=27-1,
where T is the number of taxa), D is the number of data patterns?, C is the number of discrete cate-
gories of the gamma distribution (typically, 4), and S is the number of possible character states
(§=4, $=20, and S=64 for DNA, protein, and Codon characters, respectively). P, is the number of
CPU cores assigned to the parallelization of replicates: doubling the number of CPU cores assigned
to_different replicates doubles the speed of the search but also doubles the amount of required
RAM.

The number of trees (77) used at each generation by MetaPIGA depends on the heuristic chosen:
T, =3 for ‘Hill Climbing’ (HC) and for ‘Simulated Annealing’ (SA);
T, = I+1 for the ‘Genetic Algorithm’ (GA) under ‘Improve’, ‘Replacement’, and ‘Keep the best’ selection
schemes;
T, = I*2+1 for the ‘Genetic Algorithm’ (GA) under ‘Tournament’, and ‘Rank’ selection schemes;
T- = P*I+1 for the ‘Metapopulation Genetic Algorithm’ (MetaGA) under Tmprove’, ‘Replacement’, and ‘Keep
the best’ selection schemes;
T, = (P+1)(I+1) for the ‘Metapopulation Genetic Algorithm’ (MetaGA) under ‘Tournament’, and ‘Rank’ selec-
tion schemes with one CPU core;
T, = 2P)(I+1) for the ‘Metapopulation Genetic Algorithm’ (MetaGA) under “Tournament’, and ‘Rank’ selection
schemes with more than one CPU core;

P is the number of populations and / is the number of individuals per populations.

N S Y

For example, using a computer with 4 CPU cores, and using the metaGA (with ‘Improve’Selection)
with 4 populations of 4 individuals, and rate heterogeneity with 4 Gamma-rate categories on a DNA
dataset of 120 taxa and 4000 nucleotides (hence, about 2500 data patterns, although that number
can vary, depending on each specific dataset), will require about:

a. 2.4 Gb of RAM for a single core assigned to each replicate but 4 cores assigned to 4 simul-
taneous replicates;

b. 1.2 Gb of RAM for 2 cores assigned to each replicate and 2 cores assigned to 2 simultaneous
replicates.

Note that option a. will be significantly faster than option . Also note that:

v The amount of RAM computed above is a lower bound as the storage of the dataset itself can
take a few hundreds Mb;

v An estimate of the amount of RAM necessary for your analysis is indicated in the parameter
summary panel of the main window (Fig. 2) as well as in the lower-left corner of the ‘Analysis
settings” window (Fig. 9 to 18), on the basis of the parameters you have chosen in that same

2 A data pattern is an aligned column with a specific combination of states. One pattern can occur several times within
the same dataset. For example, the character columns 1, 8 & 9 below are identical, hence, their likelihoods are identical
and must be computed only once (but used three times for computing the joint likelihood). Similarly, characters 3 & 7
are identical. The example dataset below exhibits 9 characters but only 5 patterns. The number of data patterns is indi-
cated in the ‘MetaPIGA data matrix’ tab (see Fig. 3)

Character-->1 2 3 4 56 7 8 9 Pattern --> 1 2 3 4 5
Taxonl AGTGCCTAA Taxonl AGTGC
Taxon2 AGTGCCTAA Taxon2 AGTGC
Taxon3 TTTGCCTTT -> Compress -> Taxon3 TTTGC
Taxon4 TTTGCCTTT Taxon4 TTTGZC
Taxon5 T-TGCCTTT Taxon5 T -TGC
Pattern --> 1 2 3455 311 Weight --> 3 1 2 1 2
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window. In both windows, the estimate turns red if you exceed the amount of memory you allo-
cated to MetaPIGA.

As indicated in Figure 1a, you can choose the amount of RAM assigned to MetaPIGA in the menu:
‘Tools’ => ‘Memory Settings’). You will be prompted by the program to do so if you experience an
out-of-memory error during the use of MetaPIGA. The amounts of memory assigned, used, and
available can be found in the menu ‘Help’=> ‘System informations’(Fig. 1b).

8.0.0 Memory settings .00 System information

Set maximum memory allowed to MetaPICA :

3584
= = 3840
f = Available processors : 4
E = 4352 System available memory : 8 192 Mb
- - :ggf m Memory allocated to MetaPIGA : 4 087 Mb
5120 Memory currently used by MetaPIGA : 14 Mb
5376
5632 |«
5888 [
Cancel ) ( OK )

Fig. 1: The metaPIGA (a) Memory Settings and (b) System Information windows

Graphics card memory. For best performances, the graphics card must have enough built-in
memory. To calculate the minimum amount of memory in megabytes, use the following formula:

12.C-D-S+8-C-D+16-C-S°+8-C+12-D+16-§* +16-8§

RAM " (Mb) = -
1024

opt

Where D is the number of data patterns (see above), C is the number of discrete categories of the
gamma distribution (typically, 4), and S is the number of possible character states (S=4, S=20, and
S=64 for DNA, protein, and codon sequences respectively).

If the amount of available memory is less than that computed above, MetaPIGA will have to split
the data into pieces before sending it to the GPU, which in turn degrades the performances of the
GPU. To calculate the minimum of built-in GPU memory needed, use the following formula:

8 C+12-D+8-C-D+16-S+384-C-S+16-S* +16-C-S’

RAM Y (Mb) = -
1024

min
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5. Using MetaPIGA

5.1. Summary

MetaPIGA uses standard formats: reading and writing datasets in Nexus format [40] and trees
in Newick format. Note that aligned datasets in Fasta format can also be imported in MetaPIGA. All
search settings can be saved in a metaPIGA block incorporated into the Nexus file, allowing easy
management and runs on distant servers. A Nexus file without a metaPIGA block will be correctly
interpreted by MetaPIGA and will run with default parameters (but it will skip other programs
blocks such as ‘Paup’ or ‘Assumptions’ blocks). Note that the command “Endblock™ often used in
Paup data files is not a standard Nexus command and will not be recognized by MetaPIGA (please,
use the standard Nexus command “END” instead). The minimum requirements are a DATA block
(defining the datatype, the number of taxa and the number of characters), including a MATRIX com-
mand (i.e., with the sequence data; if the matrix is in interleave form, please, indicate it in the DATA
block) with each sequence beginning with the sequence name separated from the sequence itself by
at least one space. Standard ambiguity characters are accepted (see below) and missing data (de-
fined by the ‘MISSING’ command; default is ‘?’) are automatically converted to ‘N’ (nucleotide se-
quences) or ‘X’ (amino-acid sequences). Gaps (defined by the ‘GAP’ command; default is ‘-”) can be
removed (with the corresponding character in other taxa) or treated as ‘N’ (see Section 5.3).

Example of Nexus file with nucleotide data. The standard ambiguity code for DNA sequences.

#NEXUS
BEGIN DATA;

DIMENSIONS NTAX=5 NCHAR=12; M=2aorcC

FORMAT DATATYPE=DNA interleave V=2 o0or CorG (notT)

R =A or G

MISSING=? GAP=- ; H=A2A or C or T (not G)
MATRIX W=2 orT
mysequence T1 AGTGCCTGATTG
mysequence_ T2 AGTGCCTGATCG D =~A or G or (not C)
mysequence T3 TTTGCCTG---G §=CorgG
mysequence T4 TTTGCCTAATCG B =Cor G or (not A)

T-TGCCTAATCG N=Aor Cor Gor T

mysequence_T5

’
END;

Example of Nexus file with protein data. The standard ambiguity code for PROTEIN se-

#NEXUS quences.
BEGIN DATA;
DIMENSIONS NTAX=5 NCHAR=12;
FORMAT DATATYPE=PROTEIN interleave B=NorD
MISSING=? GAP=- ; Z =Q or E
MATRIX J=1o0or L
mysequence_S1 QSGT X = any amino-acid

mysequence_S2 RSGT
mysequence S3 P-GK
mysequence_S4 RLGK
mysequence_ S5 RLG-

14
END;

MetaPIGA can be run in command line (cf. end of ‘Section 5.2°, then jump directly to Sec-
tions 5.7 and 5.8 as well as Appendix 2), but it also offers an extensive graphical user interface
(GUI) for access to:

v Dataset setting (Fig. 4-9) : defining and managing charsets; including/excluding taxa, characters,
and charsets; defining and managing dataset partitions; changing nucleotide sequences to codon
sequences and vice versa;
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v Analysis settings (Fig. 10-18): choosing and customizing heuristics; defining substitution models
and their parameters; choosing starting-tree options; controlling operators; defining stop criteria
and replicates, managing multi-core processing.

All settings are associated with an interactive ‘mouse-over’ help system such that, if you are an
experienced phylogeneticist, you probably don’t need this manual much ;).

MetaPIGA implements simple dataset quality controls (testing for the presence of identical
sequences and for excessively ambiguous or excessively divergent sequences) and automated trim-
ming of poorly aligned regions using the trimAl algorithm [2]. MetaPIGA also implements statisti-
cal methods for selecting substitution models that best fits the data ([41]; and refs therein): the
Likelihood Ratio Test, the Akaike Information Criterion, and the Bayesian Information Criterion.

The MetaPIGA GUI provides a detailed run window showing graphs specific to the corre-
sponding heuristic. For example,, for a metaGA search with replicates, the run window shows: (i)
the current best likelihood progression of each population and (ii) the current topology, posterior
probability values, and average branch lengths of the consensus tree.

Batch files are particularly useful for running sequentially a single data set under multiple dif-
ferent settings or several datasets with the same settings. MetaPIGA supports the use of batch files
that can be either written manually (see Section 5.8) or generated using tools available in the GUI
(see Section 5.7): datasets and their settings can be duplicated, settings can be “stamped” from one
dataset to another, and multiple combinations of datasets and settings can be saved in a batch file
that can be run either in the GUI (with various graphical information on search progress) or using
command line.

Input and result trees are manipulated in Newick format, but visualized graphically in the
GUI, and can be exported for other programs. MetaPIGA also integrates a Tree Viewer that allows
viewing, re-rooting, and printing trees as well as computing the likelihood of any tree (under any
available substitution model) and optimizing its model parameters. Five other tools are imple-
mented: a Tree Generator (using the starting tree settings), an Ancestral State Reconstruction
viewer (associated with the Tree Viewer), a Consensus Builder (using user-trees and/or trees saved
in the ‘Tree Viewer’), a tool for computing Pairwise Distances, and a Memory Settings tool defin-
ing the maximum amount of memory allocated to the program. See section 5.9 for details.

5.2. Launching MetaPIGA & opening a file

5.2.1. Loading a file
Double-clicking a ‘“.nex’ file (on Windows and Mac OS X) launches MetaPIGA and opens the
Nexus file. If it does not, launch MetaPIGA by double-clicking the application icon and open your

NEXUS (or FASTA) file by clicking on the ‘Load Nexus file’ button (Figs. 2 & 3) or by select-
ing in the menu: ‘File’=> ‘Load a Data File (Nexus or Fasta format)’. Several Nexus files can be
loaded sequentially using the Load Nexus File button/command but multiple files can also be
dragged and dropped from the OS navigator to the left panel of the MetaPIGA main window (Fig.
2). The upper-right and lower-right panels of the main window indicate the parameters and the data
matrix, respectively, obtained from the corresponding Nexus/Fasta file (Fig. 2). The entry window
gives access to a second tab (arrow in Fig. 2) that shows the compressed data matrix and indicates
the number of data patterns and base frequencies.

5.2.2. Data quality control & alignment trimming

Hitting the ‘scissor’ button (%Fig. 2) in the center of the main window will successively launch

quality tests for:

v The presence of excessively ambiguous sequences: sequences with >40% ambiguities (gaps and
N/X) will be detected and will be proposed to be automatically removed.
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v The presence of redundant sequences: groups of identical sequences will be detected and only
one sequence (with the lowest number of ambiguities) will be kept for each such group?.

v The presence of excessively divergent sequences: if sequences generating large uncorrected
pairwise distances (85% for proteins, 65% for nucleotide data, and 45% for standard binary data)
are detected, a warning is given, suggesting to remove these sequences and to subsequently rea-
lign the dataset. MetaPIGA does not perform alignment, so you’ll have to realign your sequences
using an alignment software such as ClustalW or CodonCode Aligner.

v Automated trimming of poorly aligned regions using the #rimAl algorithm [2]: excessively
gapped and/or divergent positions are put in a charset of excluded characters (but they can be
easily re-included in the ‘Dataset settings’, see section 5.3).

Each of these 4 tests is also separately accessible in the 'dataset' menu.

The trimAl algorithm has not yet been implemented for codon sequences in the MetaPIGA

version 3.0.

2BO] OK|7 ®%w#

Use this slider to change the selected dataset priority in a batch run T

a_1b
JPERVISED) with 4 populations, 4 individuals, a tolerance
ND

n criterion Maximt Likelihooc { matrix R for TREE using JC model and NONE distributior

rithm, on branch lengths
6 of invariant

1111111111222222222233333333334444444444 6666666667777777777888888888899999999990000000C
12345678901234567890123456789012345678901234567890123456789012345678901234567890123456789012345678901234567

ARCATCACT!
TGAACATAAGTGTT
TCATGAACATAAGTGTT
CCTTCACTATCATGAACATAAGC
STTCTCATTCACTATCATGARCATAAGTGTTCCC
CATTTACCATCATGAACATAAGTGTT
CATTCACCATCATGAACATAAGTGTT!

GTACGTTTCTCATTTA
TGTACGCTTTTCCTTT
GCAGTGCGTTTCTCATTTACAGTCATGAACATTAGTGTTCCC, ~AATGGGTCTGTTAGAATTTTT
GCAGTACGTTTCTCATTTACARTCATGAA' GTG! TTCGGATTTTT
TTCGAGTTTTT!

TTCATTTA
TTTCTCATTC
GTACGTTTCTCATTCACAATCATGAACATCAGC CAA’
GCAGTTCCCGAGARAGCTGTACGSTTCTCTTTTACACTCATGARCATYAGCTGTCCTGGTAAT -~

Nexus data matrix | MetaPIGA data matrix

Data file successfully loaded

Fig. 2: The MetaPIGA main window with three loaded datasets and the ‘ranoidea 1b’ dataset selected. The arrows
indicate the memory required for running that dataset (under the current settings), the central button for data quality
control & alignment trimming, and the second tab giving access to the compressed dataset, number of data patterns,
and base frequencies.

3 Ambiguities are considered as such during comparisons of sequences. For example, in the dataset below, there are two
groups of identical sequences (seq.1+2+3 and seq.4+5). After running the test, MetaPIGA keeps, within each group,
only the sequences with the lowest number of ambiguities (sequences 1 and 4).

Sequencel AGTGCCNGA
Sequence? AGYGCCTRA Sequencel AGTGCCNGA
Sequence3 ANTNC-TGA -—> Sequence4 TTTGCCT-T
Sequenced TTTGCCT-T
Sequenceb5 T --GCCTAT
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The icons in the upper-left cor- [C] Close selected file [U] Duplicate selected file

ner of the window (Flg 3) are [S] Save selected file [Dsle?tia:;u [O] Associate settings
shortcuts to the main com-

N\ /
mands from the  ‘File’, / ﬂg@ él /\jj ﬂ 4\;‘/@ 105

‘Search’, ‘Batch’, and ‘Tools’

1 { [L] Load Data file [A] Analysis [1S] Save all files in
menus. Most of these functions [(hlje:us or Foot) Settings T Nowrs bateh
are self-explanatory and are

[R] Run heuristics search  [ftR] Run batch
associated with an interactive
‘mouse-over’ help system. We Fig. 3: The MetaPIGA main functionalities icons. These functionalities
(and others) are also available through the ‘File’, ‘Dataset’, ‘Search’,

Wﬂ_l however .Chscu.S.S below the ¢ ‘Batch’, and ‘Tools’ menus. Between brackets: shortcut command letters.
MAJor  fUNCHONALITIES.  IMIOST

commands can be called using
a short-cut of type ‘Ctrl/Cmd+letter’ (e.g., ‘Ctrl/Cmd+L’ for opening a Nexus or Fasta file).

[T] Tree viewer

NOTE: COMMAND LINE LAUNCH. It is particularly useful to launch MetaPIGA in command line if you want to
send jobs to a distant server. You must use the ‘mp_console’ executable (and not ‘MetaPIGA’). Simply type the com-
mand “mp_console” with the following arguments:

v [noupdate] : MetaPIGA will not check the MetaPIGA download server for an update;

[nogui] : MetaPIGA will run without graphical interface (but textual progress), executing all files given in argument.
[width=] : set the console width (default = 80). Necessary for progress bar display without GUI.

[silent] Launches MetaPIGA without any GUI or text progress.

[aFilename] : The Nexus/Fasta file that will be opened by MetaPIGA and executed if [nogui] is set. If several file-
names are given, they will be run sequentially as a batch.

For example, to run sequentially two nexus files ‘filel.nex’ and ‘file2.nex’ withtout GUI under Windows, type:
“mp_console.exe noupdate nogui filel .nex file2 .nex”

Refer to ‘Section 5.8” on how building batch files manually, and to ‘Appendix 2’ for the full list of MetaPIGA com-
mands that can be incorporated in Nexus files.

v
v
v
v

5.3. [D] Dataset Settings

5.3.1 Overview

The dataset settings are accessed by clicking on the button or by selecting in the menu:
‘Dataset’ => ‘Dataset settings’. This window allows to:
v define and manage charsets;
v include/exclude taxa, characters, and charsets;
v define and manage dataset partitions;
v define outgroup sequences;
v define a range of Codons inside a nucleotide sequence.
This window is divided into two tabs. The first tab (Dataset) handles charsets, partitions, outgroups,
and excluded taxa. The second (Codons) allows defining Codon characters in nucleotide sequences.
The corresponding window for the ‘ranoidea_1b.nex’ file is shown below (Fig. 4). The 7 out-
group taxa and the 10 charsets were predefined (hence, recognized by the program) in the nexus file
using a metaPIGA block as highlighted in green below. See Appendix 2 for the full list of
MetaPIGA commands.
#NEXUS
BEGIN DATA;
DIMENSIONS NTAX=111 NCHAR=3679;
FORMAT DATATYPE=DNA interleave MISSING=? GAP=- ;
MATRIX
The data matrix is here in interleaved format
éND;
BEGIN METAPIGA;
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charset name=RAGl set{1-555};

charset name=rhodl set{556-870};

charset name=rhod4 set{871-1045};

charset name=Tyr set{1046-1579};

charset name=12V16 set{1580-3080};

charset name=16S set{3081-3679};

charset name=RAG_AmbigAlign set{67-84};

charset name=Tyr AmbigAlign set{1211-1228};

charset name=12V16 Ambigalign set{1610-1615 1671-1684 1721-1762 1784-1801 1817-1867
1892-1900 1911-1915 1953-1999 2048-2055 2070-2086 2107-2116 2128-2199 2208-2219
2237-2262 2287-2304 2308 2324-2332 2349-2352 2363-2370 2378-2390 2411 2431-2454
2567-2611 2673-2700 2722-2728 2742-2831 2864-2884 2900-2988 3022-3080};

charset name=16S_AmbigAlign set{3090-3103 3128-3136 3149-3158 3318-3398 3438-3507

3513-3527 3649-3679};
outgroup {1004NesTho 0986DenAur 1052HylAre 0987PhrVen 1006CerOrn 1082LepMel 1037Telsp.};
end;

All commands can be performed with the GUI (instead of using commands in the Nexus file) as de-
scribed below.

5.3.2 The ‘Dataset’ tab 8006 Dataset settings

Use the >> and << but-
tons to (i) transfer taxa in and e e et pariions
out of the outgroup, (i) = Gsinie E C=> sosremmuen RAGL =
exclude/include taxa, (iii) | oszaswwe § CS=D osseoemu 116 <<
consider/disregard pre-defined Eggggpgp Los v ©
charsets as partitions, and (iv) 0933 AgMad Excluded taxas Excluded charsets
include/exclude character sets Tosetakre 1216 AUBIGALGN
from the analysis. Character wsseaon | | - [
sets (‘charsets’) can be defined égéggf'p g g
and managed using the inter- oms T T
face (see below). In Fig 4, one s
taxon and four charsets were = el
excluded manually. The Remove columns (characters) ( Define new charset ) ( Define pos 1,23 ) (Edit charset)
‘Charset viewer’ button allows e 2 CTRD) @ LT et ("Delete charser ) (_Charset viewer )
selecting and visualizing any of
the charsets (highlighted in the Fig. 4: The ‘Dataset settings’ window.

full dataset). Clicking on the
‘Define new charset’ button
opens a window for selecting characters to include in the new charset. Multiple selections can be
performed with the mouse (and shift/ctrl/cmd keys depending on your OS) or a range selection tool.

8enNo NEW CHARSET [ JeNe) ¢ NEW CHARSET

Mouse selection Position Mouse selection ‘," Position

(" Add selection ) (" Addrange ) ( Add selection ) ( Addrange )

P— 1[3) to [ 3,679 [%] using step of 11(3) 8 p g 1] to [ 3.679/(%) using step of 1[}) —/—77=
Remove selection Remove range Remove selection Remove range

EEEEEEEREEEEEEEEENEEENEE

L6 23
A|C A
AlC Al
G[C A
G[C Al
G[C A
A|C A
AlC A
T[C A
T[C A
c[C A
c[C A
T|C A
T|C A
c[C A
T|C A
K[C A
T|C A
T|C A
T|C A
T|C A
C|C Al
c[C A
C[C Al
c[c A

EEEEEEEEEEEEEREEEEREEEEREE |
olo[alalalalalalalala[alalalalalalalalalalalala

EEEEEEEEEEEEEEEEEEEEEEEE

e (EancE )
SAVE CANCEL
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In the first example (Fig. 5), a set of 9+4+7 characters have first been selected with the mouse, then
added to the charset under construction by using the ‘Add selection’ button (red arrow in Fig. 5).
That button can be used multiple times to sequentially add different sets of characters to your new
charset. Once a selection has been added, its colour is changed to avoid any ambiguity. Once click-
ing the ‘SAVE’ button, you will have to supply a name (here, we used ‘MYCHARSET’) for the new
charset and it will appear in the list of available charsets (Fig. 7).

Note that a charset can also be

(N NEW CHARSET

selected using the range selection tool Mouse selection Position
as in this second example (Fig.6) S T | [ ——————— Jp— QI
(" Remove selection ) v} to x) using step o = ( Remove range )

where nucleotides between position 1
and 300 have been selected every
three positions. This allows for exam-
ple to easily define 1st, 2nd| and 34 po-
sitions in a protein-coding sequence.
The mouse selection tool (Fig. 5) and
the range-selection tool (Fig. 6) can
be used in combination. If your data-
set is exclusively made of in-frame
protein-coding nucleotide sequences,
quick definition of first, second, and
third positions can be performed using
the ad-hoc ‘Define pos 1,2,3’ button in == I
the ‘Dataset settings’ (Fig. 4). '

Charsets can then be excluded/

A|
[T [
B
[T [
[T [
E|
7]
[A @
A]
[A]
A9
A]
[A]
[A e
A]
<]
[A e
A]
7]
A]
A @
A]
Al

alalalolalalalalalalalalalalalalal talalalalal B
HEEEEEEEEEEEEEEEEEEEEEEE
SEEEEEEEEEEECEEEEEEEEEES
> ‘ ‘ ‘ o i N 4

NEEEEEEEEEEEEEEEEEECEEEE

: Fig. 6: Defining a character set with the range-selection tool.

included from the analysis ()I' af\omase‘semngs
considered/disregarded for data parti- et
tioning . In the example ln Flg . 7 , We : Taxa Outgroup Charsets Partitions
. 0943Artvar ) ) 1004NesTho TYR ) . 16S
have 7 taxa in the outgroup, 1 ex- 0g47schsch E (C2>) |Loaztepmel RHODS C) [Mronarser
. 0942AfrDor y . 1006CerOrn RHOD1 y ~\
cluded taxon, 1 1 charsets of which 4 oszammspe ) (=< ossepenar 1216 =<0
are excluded (in the present case, et osarive
. . . 0933AgIMad Excluded taxas Excluded charsets
these are amblguously allgned pOSl' gg;;:gnag‘ OQQQHemI\;ar TYR AMBIGALIGN '
K R . : anUlc 12V16 AMBIGALIGN
tions for different genes, hence, it was = &, RAG AVBGALIGN
H 1055ElaOva
chosen to remove them from the |  |wscso | (>0 &
H 0102KalTap . p .
analysis), and 3 partitions: ‘/6S’, Sosonimmg | | (=)
1224AfrFus
‘MY_CHARSET’, All other non-excluded izioanl
characters (automatically grouped into Dosacacee |3
a Virtllal Charset named “REMAIN' Remove columns (characters) (" Define new charset ) ( Define pos 1,2,3 ) ( Edit charset )
ING”)4. 5 @ None O With gap(s) O With gap(s) or N(s) ( Delete charset ) ( Charset viewer )

(" ok ) (CANCEL)
Gaps. The user can choose to remove,
before the analysis is performed, ei- Fig. 7: The ‘Dataset’ Win(_]qu _after defining the new charset
. ¢ (‘MY_CHARSET’) and partitioning of the data.
ther all columns with at leastone gap, = =~ — """
or at least one gap or one ‘N’ (‘A’ or
‘Cor ‘G’ or ‘T).

“We assume that all partitions evolve on the same topology, but all other parameters (base freq, substitution matrix rates, shape pa-
rameter of y-distr, and proportion of invariable sites Pinv) are estimated and optimized separately for each partition. Among-partition
rate variation parameters are introduced in the likelihood equation as a factor that modifies branch lengths for the corresponding par-
tition. Branch lengths are optimized as usual, but the relative rates of partitions are optimized separately (with the constraint that the
weighted average of among-partitions rates is 1; weighting is according to each partition’s size). See Appendix 3 for details.
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5.3.3 The ‘Codons’ tab

The codon tab consists of a codon range viewer and two buttons that are used for codon range
definition. Codons are indicated with black letters on a light green background. The remaining of
the dataset is colored inversely

eNO Dataset settings

(Fig. 8). Pressing the ‘Make )

codons’ button will open the
codon maker window where
you can define (i) the range of
the coding sequence and (ii)
the genetic code you wish to

use (i.e., The Universal Code,
the Vertebrate Mitochondrial
Code, etc., see below). The (Make codons ) (_Revert o nucieotides )

range of coding sequences can
be defined by manually picking o e
the first position in the dataset Fig. 8: The ‘Codons’ tab after defining the codon range within the

and pressing the ‘Set as first po- ¢ sequence. The Codon range is marked with the green background.

sition’ button in the ‘Pick posi-

tion’ tool in the upper left corner ( e - ) 3
Universal Codon Table )

of the window (Fig. 9, highlight

a). Similarly, pick the last posi-

tion in the dataset and press the
‘Set as last position’ button. Al-

[T [T[A[T[T]A[CA[C[T[C|C[A[CIA[TIT[A[TCIA[C]
[AIGIGITITIGIAICITITIAITITIAICIAICICICICIGIGIAIGI TIA[TIGICITIGITIC]

ternatively, define the range by
entering the indexes of the first
and the last positions in the top
middle part of the window (Fig.

9, highlight b). Note that the |

first and last positions must de- . Fig. 9: The codon maker. Tools for defining codon range (a and b), the

. ¢ drop-down menu for selecting a DNA code (c), and the range of :
fine a range corresponding to a i nucleotides selected as codons (d, in purple) are indicated.
multiple of 3 nucleotides. TF this

is not the case,, the codon maker will trim the range to the closest smaller third nucleotide position.
Also, note that if some of the codons are either stop codons or ambiguous codons, the codon maker
will exclude the corresponding codons and a warning will pop up. Important: The nucleotides out-
side of the defined range of codons will be ignored during subsequent analyses. If you have charsets
defined before the translation to the codons, these charset will be available only if they are compati-
ble with the codon range. These incompatible charsets will become available again as soon as you
revert to the nucleotide character mode (see below). If you are saving a codon range to a nexus file,

the incompatible charsets will not be saved.

The genetic codes (for codon translation) available in the drop-down menu (Fig. 9¢) are:
The Universal Code;

The Ciliate, Dasycladacean and Hexamita Nuclear Code;

The Echinoderm and Flatworm Mitochondrial Code;

The Euplotid Nuclear Code;
The Invertebrate Mitochondrial Code;

Y

MetaPIGA 3.0 manual ‘!r—' “plé



v the Mold, Protozoan, Coelenterate Mitochondrial & The Mycoplasma/Spiroplasma Code;

v The Vertebrate Mitochondrial Code.

For additional information on genetic codes, please check: http://www.ncbi.nlm.nih.gov/Taxonomy/Utils/wprintgc.cgi.

Once you have defined the codon range and the genetic code, press the ‘Save’ button and proceed to

defining your Analysis Settings (section 5.4 below).

Revert to nucleotides. To revert defined codons back into nucleotide characters, please press the

‘Revert to nucleotides’ button (Fig. 8). If some of your charsets became unavailable during codon

definitions, they will re-appear in the list of charsets.

5.3.4 Exiting the Settings Window

Once outgroup sequences, charsets, partitions, and excluded sequences and charsets have been de-
fined (and, potentially, the range of codons), and the ‘OK’ button has been hit, the main (entry)
window is updated (Fig. 10): the upper-right window lists the new settings and the lower-right win-
dow indicates the excluded characters and excluded taxa in red, and the various partitions using a

color-coded font background. Switching to another dataset in the left window and modifying the

settings for that dataset does not affect the settings associates to the other datasets.

Note: A dataset can be saved as a Nexus file with both excluded taxa and excluded charset deleted from the
DATA matrix. To do this, use the menu 'File > Save modified dataset to Nexus'.

[ XoNe) Metapiga 2.1

28O @ X B ®|%t|# @

Use this slider to change the selected dataset priority in a batch run T

ers/mi
Pruning
ion and ct

ons, 4 individuals,

te matrix R for TREE using JC model and NONE distributior

Genetic Algorithm, on branch lengths, among-partition rate

variant

and apply

1111111111222

444444444
45

H Settings changes saved

Fig. 10: The MetaPIGA entry window updated after defining the settings.
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5.4. [A] Analysis Settings

The analysis settings are accessed by clicking on the button or by selecting in the menu:
‘Search’ = ‘Analysis settings’. The Settings window includes 5 tabs to switch among the corre-
sponding parameter controls relevant to: ‘Heuristic’, ‘Evaluation Criterion’, ‘Starting tree(s)’,
‘Operators’, and ‘Miscellaneous’. The user can switch from on tab to another and confirm ALL
changes by clicking on the ‘OK’ button in ANY of the tabs.
Note that the analysis settings window always indicates in the lower left corner (blue frame in Fig. 11) the
amount of memory necessary for running the analysis given the settings so far selected. When the amount of
memory exceeds that allocated to MetaPIGA, the corresponding text turns red. To alleviate the problem, use
“Tools’=> ‘Memory Settings’ (Fig. 1) to increase the memory allocated to MetaPIGA.

5.4.1. The ‘Heuristic’ tab

We implemented four heuristics in MetaPIGA: a hill climbing algorithm, a Stochastic Simulated
Annealing algorithm (SSA; [26, 42]), a classical Genetic Algorithm (GA; [27-29]), and the meta-
population Genetic Algorithm based on the Consensus Pruning principle (metaGA; [1]), all avail-
able in the Heuristic tab (Fig. 11).

The Hill Climbing (HC) algorithms

The ‘Stochastic HC’ algorithm generates a new solution tree at each step (using available operators)
and accepts it only if its likelihood is better than the current solution. HC algorithms are fast but
tend to generate solutions trapped in local optima and are therefore highly dependent on the starting
tree localizationin

tree space as well =200 Analysis settings
th ( [ Heuristic | Evaluation criterion ~ Starting tree(s) = Operators = Miscellaneous |
as on € un-

@ Hill Climbing O Genetic Algorithm
known) tree space
) p (U Simulated Annealing (U Consensus Pruning (metaGA)
topography. ]
p g p y (O Stochastic hill climbing
Hence > the user *) Random-restart hill climbing
can Choose to per_ Number of restart : 1][3)
fOI‘m ‘Random— Sand_omk—restan hill climbing - Iteratively performs N hill climbings, each time with a different initial tree. Among the N solution trees, only the
est is kept.
restart hill Climb_ Note that, when choosing the ‘Neighbor Joining’ starting-tree option (‘Starting Tree(s)’ tab), the NJ tree will only be used for the first hill

climbing, and Loose NJ trees will be generated for all restarts. Likewise, when choosing 'user trees' but the number of provided starting trees is
; smaller than N+1, LN) random trees will be generated for the missing starting trees.

ln’g Le. ) an algo_ Note also that the stop conditions (in the ‘miscellaneous tab’) are defined for one hill climbing. For example, when choosing 10 restarts and
2000 steps’ as the stop condition, 11 hill climbing of 2000 steps will be performed, but only the best scored tree, among the 11 results, will be

rithm that itera- @ e
tively performs N
hill climbings,
each time with a
different initial Fig. 11: The ‘Heuristic’ window with the ‘Hill Climbing’ heuristic selected and the

corresponding mouse-over help text. The blue frame highlights the amount of memory
required for running the analysis given the settings so far selected.

‘Estima(ion of necessary memory : 16 Mb “’ oK ) ( CANCEL ) ( setall parameters to default ) ( Set heuristic parameters to default )

tree. Among the N
solution trees,
only the best is
kept. The user can fix the number of restarts (20 by default).
Figure 11 also illustrates the ‘mouse-over’ help system of MetaPIGA: an explanatory note appears when mov-
ing the mouse cursor over the corresponding field, parameter, or radio-button, etc. In figure 11, the mouse cur-
sor is over the ‘Random-restart Hill Climbing’ radio button.

The Stochastic Simulated Annealing algorithm (SSA)

The SSA algorithm uses statistical mechanics principles to solve combinatorial optimization prob-
lems [42]; i.e., it mimics the process of minimal energy annealing in solids. The first attempt to use
this approach for the evolutionary tree problem was introduced in 1985 by Lundy [43], and its use
for ML phylogeny inference was further developed in 2001 by Salter and Pearl [26]. SSA starts
with an initial state (the starting tree) and randomly perturbs that solution (using available tree op-
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erators). If the new state is better (lower energy, better likelihood), it is kept as the new current
state; if the new state is worse (higher energy, worse likelihood), it is accepted as the current state

with the probability e**'" , where AE is the negative difference in energy (here, the difference of

likelihood) between the two states, and 7 is the so-called ‘temperature’ of the system. If 7 is low-
ered slowly enough, the algorithm is guaranteed to find the optimal solution, but if the temperature
is lowered too slowly, the time to find the optimal solution can exceed that of an exact search. The
obvious asset of the algorithm is its ability to momentarily accept suboptimal solutions, allowing it
to escape local optima whereas its obvious drawback is the difficulty to define the shape and speed
of the ‘cooling schedule’ (i.e., the rate of the decrease in 7). Efficient schedules highly depend on
the dataset. The efficiency of the algorithm is unknown and optimization of its parameters has never
been performed. Before this optimization analysis (in progress) is finalized, the SSA is provided as
is for allowing users to explore its utility. The parameters available in MetaPIGA 3 for the SSA are
described in Appendix 2.

The Genetic Algorithm (GA)
The GA is an evolutionary computation approach that implements a set of operators mimicking
processes of biological evolution such as mutation, recombination, selection, and reproduction (e.g.,
[44]). After an initial step of generating a population of trees, the individuals (specific trees with
their model parameters) within that population are (i) subjected to mutation (a stochastic alteration
of topology, branch lengths or model parameters) and/or recombination, and (i) allowed to repro-
duce with a probability that is a

function of their relative fitness = [*~° TR —
euristic valuation criterion arting tree(s) ~ Operators  Miscellaneous
Value (here’ thelr llkellhOOd)' () Hill Climbing O Genetic Algorithm O Bootstrapping
Because selection preferen- o BhGE eeaalfun balunsac)
tially retains changes that im- e e e e e
. . f : Population
prove the likelihood, the mean © soctast © sepuriad — :
score of the population im- | e St metapopataons | | meiss R
. O Tournamen O each population all:
proves across  generations. | @ O©  cach ittt | | Tl
However, because sub-optimal | = @umae paralleization SR
- o O Keep the best Cors asigned iter-pop hybriczation
solutions can survive in the 8 recombiration [ 10]@% | | 1113 w0l %
population (with probabilities
that depend on the selection | Fig. 12: The ‘Heuristic’ window with ‘Genetic Algorithm’ selected.

scheme), the GA  AllOWs, TI o
principle, escaping local op-
tima. In MetaPIGA, we implemented 5 alternative selection schemes (Fig. 12, see [1]):

v ‘Rank’: individuals are assigned a probability of leaving an offspring (i.e., a copy of themselves) as a function of

their position in a list in which they are ranked by their score. The probability for the ith individual of leaving an
offspring to the next generation is equal to:

n(n+1)(n i+ 1)

v ‘Tournament’: two individuals are drawn randomly from the population of I individuals and one offspring is
produced from the individual with the higher score. Both trees are then placed back into the mating population
and the whole process is repeated until / offspring have been generated. This is the default selection scheme
when using the GA.

v ‘Replacement’: two individuals are drawn randomly from the population of 7 individuals and two copies of the
better individual are returned to the mating pool (parents are discarded). The process is repeated s times, where s
is the selection strength. The offspring population is generated as a copy of the post-selection parent population.

v ‘Improve’: only those individuals that have improved (in comparison to their likelihood at the previous genera-
tion) are allowed to produce an offspring. Each individual that fails this test is discarded and replaced by a copy
of the current best individual.

v ‘Keep the Best’: only the best individual (i.e., with highest likelihood) is kept and all other individuals are re-
placed by a copy of the best individual.
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All selection regimes (except ‘Improve’ and ‘Keep the best’) tolerate the maintenance of poor trees
in the evolving populations, an effect which allows escaping from local optima but increases search
time (see below how the metaGA resolves that problem).

We also implement one recombination scheme where each sub-optimal individual has a
probability (determined by the user) to recombine with a better individual. Recombination is per-
formed by exchanging subtrees defined by one (if any) of the identical taxa partitions in the two pa-
rental trees (i.e., one internal branch that defines subtrees including the same taxa but with poten-
tially different sub-topologies). A recombination can be viewed as a large number of simultaneous
topological mutations.

Beside the selection scheme and the possibility to perform intra-population recombinations,
the major parameter in the GA is the population size (set by the user).

The metapopulation Genetic Algorithm (metaGA) &

This approach relies on the coexistence of P interacting popu-
lations [1] of I individuals each (P and I defined by the user):
the populations are not fully independent as they cooperate in
the search for optimal solutions. Within each population, a
classical GA is performed: trees are subjected to mutation
events, evaluation, and selection (5 alternative selection
schemes are available as in the GA above). However, all topo-

Allowed
SPR

k Allowed TXS

logical operators are guided through inter-population compari-
sons defined and controlled by ‘Consensus Pruning’ (CP; [1]):
topological consensus among trees across populations defines
the probability with which different portions of each tree are
subjected to topological mutations (Fig. 13). These compari-
sons allow the dynamic differentiation between internal

. Fig. 13: The principle of CP. Before
: atree is mutated, its topology is :
i compared with those of the best trees

from other populations; the
consensus branches (bold red) define
the partitions that can (green arrows)
and cannot (red arrows) be affected

by topological mutations; i.e., any
i operation moving a taxon across a
i consensus branch is prohibited.

branches that are likely correct (hence, that should be changed
with low probability) and those that are likely incorrect (hence,
that should be modified with high probability).

Although CP allows for many
alternative inter-population
communication procedures, we
implemented (Fig. 14) the two
that we identified as the most

Analysis settings

[Heuristic | Evaluation criterion Starting tree(s)  Operators Miscellaneous |

(O Hill Climbing () Genetic Algorithm

(O Simulated Annealing  *) Consensus Pruning (metaGA)

useful: Consensus type Operator behaviour Other
‘/ ‘Strict CP’: internal () strict () Blind Population
branches shared by all trees @ stochastic ® supervised [I—
across all populations can- Selection Operator applied to Individual
. O Rank O all metapopulations 4[7]
not be aff_eCted by tOpOlOgl_ () Tournament () each population Tolerance
cal mutations, all other in- O Replacement @ each individual — 1%

ternal branches are uncon- @ :::;ivhee - barallelization Inter-pop hybridization
strained. = R i 10][2] %
p . P M Recombination 10][3] % 05 CEE L

v ‘Stochastic CP’ (default): 1][3]

topological mutations affect-
ing a given branch are re-
jected with a probability
proportional to the percent-
age of trees across all popu-
lations that agree on that branch.

Fig. 14: The ‘Heuristic’ window with the ‘metaPopulation Genetic
. Algorithm’ selected.

The default selection method for the MetaGA is ‘Improve’ (see above). This scheme greatly re-
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duces the intra-population variability after each selection step but local optima are avoided thanks
to ‘Consensus Pruning’. In other words, the metaGA resolves the major problem inherent to
classical Genetic Algorithms by maintaining high (inter-population) variation even under
strong (intra-population) selection.

As constraining entirely an internal branch from being affected by topological mutations nec-
essarily increases the likelihood to be trapped in a local optimum, a tolerance parameter ¢ (defined
to 5% by the user in Fig. 14) is implemented, allowing any internal branch to be affected with a
probability ¢ even if the corresponding branch is shared by all trees. The user of MetaPIGA has the
choice between a ‘blind’ and a ‘supervised’ procedure for handling constrained partitions (Fig. 14).
In the former, a topological mutation that affects a constrained branch is simply aborted and the tree
is left unchanged, whereas in the latter, topological operators exclusively target branches in a pool
of acceptable (unconstrained) candidates. The ‘supervised’ procedure is used as default because
preliminary analyses suggest that it allows trees to converge faster to higher likelihoods.

The MetaGA allows for two, non-mutually exclusive, recombination flavors: ‘intra-
population recombination’ (lower-left field in Fig. 15) where each sub-optimal individual at each
generation has a probability (instead of being mutated) to recombine with a better individual from
that population (as in the GA above), and ‘inter-population hybridization’ (lower-right field in Fig.
14) where, at each generation, there is a probability (defined by the user) that all sub-optimal indi-
viduals from one random population, instead of being mutated, are recombined with one individual
from another population; sub-optimal individuals from other populations experience the normal mu-
tation procedure.

As CP provides frequencies of internal branches shared among trees across populations, it
also indicates if the populations converge towards a stable set of solutions, i.e., towards a consensus
with stable branch frequencies. Hence, CP provides a stopping rule not available to other heuristics:
the user can choose to stop the search when a series of successive mean relative error (MRE) values
remains below a threshold defined by the user. To increase independence among samples, MRE are
computed every n>1 (i.e., non-successive) generations. The user defines 7, as well as for how many
samples the MRE must remain below the specified threshold before the search stops. See Section
54.5 (The ‘Miscellaneous’ tab) for details.

5.4.2. The ‘Evaluation criterion’ tab

Setting ML Models

This window allows defining substitution models and their parameters (Fig. 15). Trees are estimated
in MetaPIGA with the Maximum Likelihood criterion (ML) using one of 5 nucleotide substitution
models for DNA sequences, one of 11 amino-acid substitution models, or one of two codon mod-
els. The implemented nucleotide substitution models are ([3] and refs therein): ‘Jukes Cantor’
JCO), Kimura’s 2 parameters’ (K2P), ‘Hasegawa-Kishino-Yano 1985’ (HKYS85), ‘Tamura-Nei
1993’ (TN93), and ‘General Time Reversible (GTR)’. The available amino-acid substitution mod-
els are: the ‘Poisson’ and ‘GTR2(’ models (extensions of, respectively, the JC and GTR models to
the 20 by 20 substitution matrix of protein sequences), and 9 empirical models for mitochondrial,
chloroplastic, and nuclear Protein sequences: ‘MtMam’, ‘MtRev’, ‘RtRev’, ‘CpRev’, ‘BLOS-
SUMG62’, VT, ‘Dayhoff’, ‘JTT’, and “‘WAG’. The implemented codon substitution models are GY
and ECM (Empirical Codon Model) [45, 46]. For the empirical protein and codon models, state
frequencies can be set to the empirical values used by the authors who designed the corresponding
model. Alternatively, state frequencies can be set to those observed in the dataset under analysis.
Analyses can be performed with Rate Heterogeneity among sites using either a discrete ‘Gamma
distribution of rates’ (y-distr) [35, 36] or a ‘Proportion of Invariant Sites’ (Pinv) [37], or both (y-
distr + Pinv). All parameters of the model (transition/transversion ratio or components of the rate
matrix, the shape parameter of the y-distr, and Pinv) can be set by the user or estimated from a NJ
tree (using the ‘Estimate starting parameters’ button, blue frame, Fig. 15).
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Fig. 15: The ML model window for DNA (top panel) and Protein (middle panel) datasets. The purple arrow
indicates the drop-down menu for selecting the character set for which the settings are being defined: all charsets
must be analyzed with the same single model (K2P and WAG models are selected in the examples shown), but the
parameter values of the chosen model (e.g., the transition:transversion ratio for K2P or the estimated aa frequencies
for WAQ) can be different for each partition. Lower panel: When using the GTR20 model (i.e., the general-time-
reversible model extended to the 20x20 aa substitution rate matrix), the 190 rate parameters can be optimized during
the search (i.e., if the RPM operator is selected), but the starting values can be set to the values of any of the
empirical models (WAG, JTT, ...
R matrix’ button (red arrow 2).

) by selecting the model in the drop-down menu (red arrow 1), and hitting the ‘Fill
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Note: for nucleotide substitution models, the ‘transition-transversion ratio’ (Ti/Tv) is the parameter called
kappa, i.e., the ratio between the rate of 7i and the rate of 7v. Because there are twice as many possible trans-
versions (AT; A—C; GoT; GC) as possible transitions (A<>G; T<>C), the kappa parameter does not
equate to the ratio ‘frequency of Ti / frequency of Tv’. For example, under the JC model, kappa=1 but ‘FreqTi/
freqTv’=0.5. For the codon substitution models kappa = ‘freqTi/freqTv’.

Note: Model parameter values can be estimated from the NJ tree using the ‘Estimate starting parameters’ but-
ton (blue frame, Fig. 15). However, if you stop the estimation before it completes, parameter values will not be
re-set to the original values but to the values obtained by the optimization algorithm right before it was
stopped.

Automated choice of best Model (LRT,AIC, BIC)

One difficulty in ML phylogeny inference is to choose the “right” substitution model: too-simple a
model will fit the data poorly and can lead to erroneous inference, whereas too-complex a model
will run more slowly and over-fit the data (i.e., too many parameters in relation to the data will gen-
erate an increased variance for all parameters ... the model will describe noise in addition to the
data). The softwares MODELTEST and PROTTEST (http://darwin.uvigo.es) implement statistical
methods for selecting the model that best fits the data ([41]; and refs therein). MetaPIGA makes the
procedure easier as it implements the Likelihood Ratio Test, the Akaike Information Criterion, and
the Bayesian Information Criterion and performs parameter optimization automatically: simply
choose your preferred model testing method (red frames in Fig. 15). For example, running the
Akaike Information Criterion test on the ‘ranoidea_1b.nex’ file will generate the results shown in
Figure 16: MetaPIGA proposes to use the GTR model with gamma-rate heterogeneity but no pro-
portion of invariant sites. Accepting this proposition will set this model in MetaPIGA as well as the
starting parameter values (here, rate parameters and gamma distribution shape parameter) to those
evaluated during the test. As the various models are tested in parallel on all the CPU cores of your
machine, MetaPIGA will warn you if not enough memory is available, a problem that can easily be
alleviated by reducing the number of cores allocated to the task (blue oval in Fig. 16).
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Note: that partitions (defined in the ‘Dataset Settings’ window, Figs. 4-10) are taken into account when per-
forming a ‘Model Test’. Given that model testing can take several hours to run on large datasets (especially
with protein data, given the number of models to compare), MetaPIGA allows you to restrict model testing
(Fig. 16) to the comparison of a subset of models.

Note: if you want to abort model testing (e.g., because you forgot to include/exclude taxa and/or charsets, or
want to change your partitioning of the data), hit the ‘CANCEL TESTING’ button: testing will be aborted and
all optimizations performed so far will be ignored. On the other hand, hitting a ‘CANCEL CURRENT’ button
will stop optimization on the model being currently evaluated; obviously, the results of the statistical tests will
then be contestable.

Intra-step optimization

All parameters of the model (transition/transversion ratio or components of the rate matrix, the
shape parameter of the y-distr, and Pinv), branch lengths, and among-partition relative rates can
experience ‘Intra-step optimization’ (blue frame in Fig. 15) either periodically during the search
and/or at the end of the search. The principle of stochastic methods (i.e., inter-step optimization
methods), such as MC3 approximations of the Bayesian approach, stochastic simulated annealing,
and genetic algorithms, is to AVOID intra-step optimization. Hence, the default in MetaPIGA is that
all target parameters (chosen by the user) are NOT optimized intra-step (only the consensus tree
obtained after replicated searches -- see section 5.4.5 -- will have it’s model parameters optimized).
Hence, the stochastic heuristic itself will optimize topology, branch lengths and other model pa-
rameters during each search. When using the 'discrete' or 'stochastic' options (blue frame, Fig. 15),
current best tree(s) are also optimized during the search, respectively every s numbers of steps or
with a probability p at each step. These two options can obviously greatly increase running time.

Note: For intra-step optimization, MetaPIGA implements a single algorithm: a genetic algorithm without re-
combination; each tree to optimize is copied 7 times and the population of 8 individuals experiences mutations
(on selected targets); selection is performed with tournament; the GA is stops when the likelihood remains un-
changed for 200 steps (generations). Future versions of MetaPIGA will also include alternatives to the GA
(such as, possibly, the Powell’s algorithm).

Note: the ‘consensus tree only’ option (blue frame, Fig. 15) is equivalent to the “never” option when perform-
ing a single search (one replicate). The two options differ only when preforming multiple replicates (see sec-
tion 54.5 below). When target parameters are optimized every s steps or stochastically, optimization is also
performed at the end of (each) search.

5.4.3. The ‘Starting tree(s)’ tab
As shown in Figure 17, the user can choose to produce the starting tree(s) either as NJ Tree(s) [47]
or as Random Tree(s) (i.e., with random topology and random branch lengths) or as ‘Loose Neigh-
bor Joining’ (LNJ) tree(s), i.e., a pseudo-random topology (modified from [1]). For generating a
LNIJ tree, the user specifies a proportion value (p=[0-1]) and, at each step of the NJ algorithm, the
two nodes to cluster, instead of corresponding to the smallest distance value, are randomly chosen
NTax(Ntax—1)p

from a list containing the smaller distances, where NTux is the number of se-

quences in the dataset. Branch lengths are computed as in the NJ method. In other words, the LNJ
tree is a NJ tree with some topology randomization which amount is defined by the user. This
approach is a particularly useful compromise between random starting trees (p=1) that require long
runs of the heuristic for optimization, and a good but fixed topology (the NJ tree, i.e., p=0) that
might be prone to generate solutions around a local optimum. The LNJ starting tree method is par-
ticularly well adapted to the metaGA. Indeed, starting from 7*P (where I is the number of individu-
als (trees) per population and P is the number of populations) random trees will significantly in-
crease the search time whereas starting from /*P identical NJ trees will cause the stopping rule to be
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reached too fast (see below) with local optima solutions. On the other hand, LNJ starting trees
provide enough variation among populations for avoiding local optima but significantly
speed-up the search in comparison with using ‘True random’ starting trees.

(S TONG) Analysis settings

" Heuristic = Evaluation criterion Starting tree(s) | Operators = Miscellaneous

Tree generation Distance ma; Rate heterogeneity Invariable sites
C, Neighbor Joining Q GTR @ None @ None
@ Loose Neighbor Joining () TN93 () Discrete Gamma () P-Invariant
Range 10][7] % () HKY8S shape 0.5 Proportion 0 %
() True Random O K2p Base composition
() User tree(s) ® JC Equa

Nane Estimated
NOone

*) Constant

Fig. 17: The ‘Starting tree(s)’ window.

Note: The distance matrix used for building NJ or LNIJ starting trees can be computed using any of the available substitution

models (see above) and with or without Pinv and/or y-distr. Unless the user wants to start with trees with the highest likelihood

possible, we recommend using a simple and fast model (e.g., JC and Poisson respectively for nucleotide and protein data) for

generating starting trees as they will anyway be highly modified during the heuristic search. For codon substitution models, three

distance matrices are calculated (for codon positions 1, 2, and 3) using one of the available nucleotide substitution models. These

three matrices are then weighted based on the evolutionary information they provide and combined into the single distance ma-

trix [48]

Note: When choosing the ‘Neighbor Joining’ starting-tree option during a ‘Random-restart hill climbing’ search (Heuristic tab,

section 5 .4.1), the NJ tree will only be used for the first hill climbing, and ‘LNJ trees’ will be generated for all restarts.

Note: Arbitrary starting trees (in Newick format) can also be imported by the user. When clicking on the ‘User tree(s)’ radio

button then on the ‘select’ button (Fig.17), you will prompted to choose starting trees from a list. Various buttons allow you to

add more trees in that list either from the ‘TreeViewer’ or from Nexus files.

Notes: if the Nexus file contains user trees (in a Tree Block) and if you select the ‘User tree(s)’ starting-tree option:

v The first tree in the Tree Block will be used if you selected SA or stochastic HC as the heuristic;

v The [ first trees in the Tree Block will be used when selecting GA as the heuristic option with / individuals (one tree per indi-
vidual);

v The P first trees in the Tree block will be used when selecting CP as the heuristic with P populations (one tree per popula-
tion);

v If there are too few trees in the list of starting trees, MetaPIGA will cycle among the available trees;

v In the case of a ‘Random-restart hill climbing’ search (‘Heuristic’ tab, section 5.4.1), if the number of provided starting trees
is smaller than N+1 (i.e., the number of restarts plus 1), LNJ trees will be generated for the missing starting trees.

5.4.4. The ‘Operators’ tab

All stochastic heuristics use Operators, i.e., the topology and parameters’ modifiers allowing the
heuristic to explore solution space. In MetaPIGA, we implemented 5 operators for perturbing tree
topology and 6 operators for perturbing model parameters (see below). These operators can be used
in any combination, either at equal or user-defined frequencies. The user can choose for these fre-
quencies to change dynamically during the search, i.e., MetaPIGA can periodically evaluate the
relative gains in likelihood produced by each operator and adjust their frequencies proportionally>.

3 If only some of the operators are made dynamic, their probabilities are assigned after subtracting from 1 the probabili-
ties of the fixed operators. A minimum operator frequency can be set to prevent operators from being switched off. In-
deed, an operator which is very inefficient early in the search could become efficient later in the search.
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In the example given in figure 18, 8eno Analysis settings
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pology operators:
v ‘Taxa Swap’ (TXS): n randomly-

Fig. 18: The ‘Operators’ tab.

4

selected terminal branches are

randomly swapped. The value of n can be set to any number between 2 (default) and the total
number of taxa (ALL), or randomly chosen (RAND) at each generation.

‘Subtree Swap’ (STS): 2 (default) or a random number (RAND) of subtrees are randomly
swapped.

The 6 other operators affect model parameters:

v

v
v
4

‘Branch Length Mutation’ (BLM) and ‘internal Branch length mutation’ (BLMint). As our pre-
liminary analyses (data not shown) indicated that branch length optimization yields external
branch lengths that are quite similar to those obtained through topology-constrained NJ (both on
a NJ topology and on a ML topology), we implemented a branch-length operator (BLMint) af-
fecting internal branches only. We also implemented a branch-length operator (BLM) that can
affect all (internal and external) branches.

‘Rate Parameters Mutation’ (RPM): This operator is not available for the JC model as the rate
parameter is identical for all possible substitutions under this model. The K2P and HKY models
consider two rates (the rate of 7i, and the rate of 7v); hence, only the kappa parameter (ratio of
Ti and Tv rates) can be affected. The TN93 model assigns 3 different rates: for transversions, for
A &G transitions, and for T<>C transitions. The GTR model allows assigning different rates for
the 6 possible substitutions: A>T, A—C, GoT, GC, A—G, and T<>C. Under the TN93 and
GTR models, the user can choose that each RPM operation affects either ‘1’ (default) randomly
chosen rate parameter or ‘ALL’ rate parameters. The ‘/° and ‘ALL’ commands are equivalent un-
der the K2P and HKY models because, although there are two rates, there is only one free rate
parameter (the other one is set to 1).

‘Gamma Distribution Mutation’ (GDM): modifies the y-distr shape parameter.

‘Proportion of Invariable sites Mutation’ (PIM): affects Pinv.

Among-Partitions Rate Mutation’ (APRM): affects the relative rates among partitions.

Notes:

e The BLM, BLMint, RPM, and GDM operators affect their corresponding parameter by multiplying the pa-
rameter’s value of the previous generation by a random number drawn from an exponential distribution (with
A=2), and shifted by 0.5 (such that the minimum value is 0.5 and the mean is 1).

e The PIM (values between 0 and 1) and APRM operators affect their corresponding parameters by multiplying
the parameter’s value of the previous generation by a random number drawn from a normal distribution (with
mean=1 and SD= 0.5). The resulting multiplier is rejected if <0.4.

e For LNIJ starting trees, the initial length of all internal branches is computed with the NJ algorithm whereas,
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for random starting trees, they are drawn from an exponential distribution (with A=1), and shifted by 0.001 (to
avoid zero length branches).

5.4.5. The ‘Miscellaneous’ tab

This window allows the user to choose stop criteria and define the parameters of replicated searches
(to obtain estimates of branches’ posterior probabilities). In addition, the user can choose which log
files to save on disk. Also, if a supported graphics card is available, the user can choose to use either
the CPU or the GPU for likelihood computation. Increase of computation speed is particularly sig-
nificant for protein and codon models.

Heuristic ] Evaluation criterion ] Starting tree(s) I Operators | Miscellaneous
Stop criteria Replicates
== it ©) Fixed number : 40
[[] [E] steps: 0 steps
~) Variable number : stopping when mean relative error
[ [ mme: L JORE 0 [ERES among 10 | consecutive consensus
[7]  Automatic : 2004 steps without significant improvement of 0.01-%4| % trees stay belov 5EH| %
Minimum 100 Maximum 10,000
[@) [ Consensus: mean relative error of 104 consecutive consensus
trees, sampled each 514 generations, stay below 504 % [Parallelizaﬁon 4 ]
Output
Label: 012898 - Primate Directory : | C:\Users\calavera\Documents/MetaPIGA results .:!,
Log files (number of asterisks indicate magnitude of slow-down / writing to disk)
Dataset Starting trees Heuristic details (*) Operator statistics [ Ancestral sequences (¥)
Distances Consensus (*%) Heuristic trees (*%) Operator details (**%) Performances (%)
Run on a GRID (XtremWeb-CH)
[7] Activate GRID ~ Server address Clientid MetaPIGA module id
Device for likelihood calculation
GPU
Move the mouse on parameters to get help.
lEsﬁmaﬁon of necessary memory : 12 Mb I [ OK ] [ CANCEL ] [ Set all parameters to default ] [ Set miscellaneous parameters to default ]
Fig. 19: The ‘Miscellaneous’ window for defining stopping condition(s), parameters for performing replicates (and
obtaining estimates of posterior probabilities under the MetaGA), and the label of the directory in which all results
will be saved. Log files to be saved on disk can also be defined. The amount of memory required for running the
analysis (blue frame) has significantly increased because a complex model is used (Fig. 14) and because 4 cores
have been chosen for parallelization (red frame).

Stop Criteria

Exactly as in the MC3 approximations of the Bayesian approach [24, 25] implemented in the soft-
ware MrBayes [31] for which the user must define a number of generations and trees to sample be-
fore stopping the search, all stochastic heuristics implemented in MetaPIGA require a stop condi-
tion. We implemented several stop conditions in MetaPIGA; any number of conditions can be set
and each one can be necessary or sufficient (Fig. 19, ‘nec.” or ‘suf.”)°. The stop criteria are: number
of steps e.g., number of generations for the GA or the metaGA), elapsed time, and likelihood stabil-
ity. The later, termed ‘Automatic’ in the GUI (Fig. 19), means that the search stops when the log-
likelihood of the best tree has not improved of more than a given percentage (defined by the user,

6 The heuristic stops when any of the sufficient conditions is met or when all necessary conditions are met. Conditions
are sufficient by default.
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0.05% by default) at any step during n steps (n also defined by the user).

Note: that, when using the ‘Random-restart hill climbing’ heuristic (Fig. 11), the stop conditions are defined
for one hill climbing. For example, when using random-restart hill climbing with 10 restarts and ‘2000 steps’
as the stop condition, 11 hill climbing of 2000 steps will be performed but only the best scored tree, among the
11 results, will be kept.

When using the metaGA heuristic, one can use the Consensus’ stopping condition based on con-
vergence of the populations of solutions. Indeed, comparing (across generations) the frequencies of
internal branches shared among the P*I trees provides a means for assessing whether the popula-
tions converge towards a stable set of solutions, i.e., towards a consensus with stable branch fre-
quencies. Hence, a stopping rule, not available to other heuristics, can be used under Consensus
Pruning (=MetaGA): the user can choose to stop the search when a series of mean relative error
(MRE) values remains, across generations, below a threshold (in %) defined by the user. In our ex-
perience, using the Consensus stopping-rule with a threshold of 5% works very well when perform-
ing replicates (for estimating posterior probabilities of clades, see below). On the other hand, if you
perform a single search in order to find the single very best tree, you might want to experiment with
either lower threshold values (e.g., 1%) or the stopping rule based on stability of the likelihood
value (e.g., 200 steps without improvement of 0.01% of the log-likelihood value).

Note: To increase independence among samples, consensus trees are sampled every n>1 (i.e., non-successive)
generations. For example, given two consensus tree, 7; and 7}, corresponding to the consensus among the P*/
trees at generations 5000 and 5005, respectively, the MRE is computed as follows:

nPartition ro_ P
P dDI @)
o | max(®; ,d);_)
MRE(T, ,Tf) = ‘ , where nPartition is the sum of taxa bi-partitions observed in 7; and 7;
nPartition

(but identical partitions are counted once), and @, and @; are the consensus values of bi-partition p in trees 7;

P P
O — d)T/

and Tj, respectively. Note that = 1 if either both @] and @] are nil, or if the corresponding

max(®’ , <I>;_ )

internal branch does not exist in either 7; or 7;. Internal branches that are absent from both 7; and 7j are not
considered. If the MRE gens000genso0s) is above the user-defined threshold (e.g., 3%), it is discarded and a new
MRE is computed for the comparison of generations 5005 and 5010. On the other hand, if MRE gens5000,gen5005) 18
below the threshold, a counter is incremented and a new MRE is computed for the comparison of generations
5000 with the next sample (here, corresponding to generation 5010). The user defines for how many samples
the MRE must remain below the specified threshold before the search stops.

Replicates
This functionality is very important because it allows estimating the support of trees and
clades. For all stochastic heuristics implemented in MetaPIGA, the user can chose to repeat the
search many times, generating a majority-rule consensus tree among the replicates. This is particu-
larly useful under the metaGA because previous analyses [1] indicate that a set of multiple
metaGA searches produces trees and clades with frequencies that approximate their posterior
probabilities. Hence, metaGA branch support values would be comparable to posterior probabili-
ties provided by MC3 approximations of Bayesian approaches. The user can either fix the number of
replicates, or specify a range of minimum and maximum number of replicates then choose to let
MetaPIGA stop automatically, exploiting the MRE metric in a similar way as the consensus across
populations in a single metaGA search (see above).

Note: Here, however, the MRE is computed using consensuses across replicates, i.e., T; is the consensus

among the final trees obtained between replicates 1 and i. No additional replicate is produced when the MRE

among N replicates remains below a given threshold. Consecutive replicates can be used because they are in-
dependent. As an example, if N is set to 10, and the first MRE below the user-defined threshold (e.g., 5%) in-
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volves replicates 1-241 and 1-242, the MRE is computed 9 additional times, i.e., between the reference con-
sensus 77241 and Tj, for j corresponding to replicates 1-243, then 1-244, then 1-245, etc. The search stops if the
inter-replicates MRE remains below 5% for 10 consecutive replicates. On the other hand, the counter is reset to
zero as soon as the MRE exceeds 5%, and the new reference tree for computing the MRE is then set to 7T7-current
replicate- ' The inter-generations (=intra-replicate) MRE stopping rule can be used in combination with the inter-
replicate MRE stopping rule, letting MetaPIGA decide both when to stop each replicate and when to stop exe-
cuting additional replicates (i.e., when to stop the entire analysis).

Note: in most cases, performing multiple replicates is aimed at generating a consensus tree and estimating
support of internal branches, hence, it is usually not important to perform a final intra-step optimization of all
model parameters at the end of each replicate. This is why the default for ‘Intra-step optimization’ (blue
frames, Fig. 15) is ‘consensus tree only’. It means that a final round of optimization for branch lengths and
model parameters is NOT performed after each replicate (this will significantly save run time and will not
change anything to the internal branches’ frequencies) but it is performed on the final consensus tree (i.e.,
model parameters and branch lengths are optimized on the consensus-tree topology). When the user chooses to
optimize best trees ‘at the end of (each) search’ the consensus tree is optimized as well. With the 'discrete' and
'stochastic' options, current best tree(s) are also optimized multiple times during each replicate as well as at the
end of each search.

The grid

To start an analysis on an XtremWeb-CH Grid, check the ‘Activate GRID’ check-box and write
your grid credentials in the appropriate boxes. If your account is active and the MetaPIGA binaries
are uploaded to the MetaPIGA module, your analysis will start on the Grid after you press the ‘Run’
button. For  user  documentation,  please refer  to the following site:
www.xtremwebch.net/mediawiki/index.php/How_use. Please, contact us for additional information.

Log files

The user can choose to write log files on disk. This is however mostly for debugging purposes and
performance testing such that only expert users might need this functionality. Selecting the log files
indicated with asterisks can (i) significantly slow down the search and (ii) fill up large amount of
disk space (with the magnitude of slow-down and fill-up approximately indicated by the number of
asterisks). All log files are written in the results folder (see below).

v Dataset - Working matrix log file - Prints the compressed dataset into 'Dataset.log'. The last row contains the
weight of each column, i.e., the number of times this data pattern is found in the data matrix.

v Distances — Distance matrix log file - Prints the distance matrix into 'Distances.log'.

v Starting trees — Starting Trees log file - Prints the starting tree(s) into 'StartingTrees tre'.

v Consensus (**) — Consensus log file - The ‘Consensus.log' file records consensuses at each step of Consensus
Pruning. It requires disk space between 100 bytes and 1Kb per taxa and per consensus recorded. For example,
recording consensuses for a dataset of 200 taxa, using the metaGA heuristic for a fixed number of 5000 genera-
tions will generate a file between 100Mb and 1Gb for each replicate produced.

v Heuristic details (*) — Heuristic search log file - The 'Heuristic.log' file records details about each step of the
heuristic. Requires disk space between 500 bytes & 1 Kb per iteration of the heuristic.

v Heuristic trees (**) — Heuristic search tree file - The 'Heuristic.tre' file records each tree found at each step of the
heuristic. It requires disk space of +/- 130 bytes per taxa per tree recorded. For example, recording trees for a
dataset of 200 taxa, using the metaGA heuristic with 4 populations of 4 individuals each, for a fixed amount of
5000 generations will generate a file of about 1.5Gb for each replicate produced.

¥ Operator statistics — Operator statistics file — The ‘OperatorsStatistics.log’ file records operator statistics at the
end of a search, as well as each time the operator frequencies have been updated.

v Operator details (***) - Operators log file - The 'OperatorsDetails.log' file records details about the operators
used. It requires disk space of 200-300 bytes per taxa per operation. For example, recording operator details for a
dataset of 200 taxa, using the metaGA heuristic with 4 populations of 4 individuals each, for a fixed number of
5000 generations will generate a file between 1.7Gb and 3.4Gb for each replicate produced.

v Ancestral sequences - Ancestral sequences log file - At the end of the heuristic, the ancestral sequence probabili-
ties are printed into the 'AncestralSequences.log' file
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v Performances (*) — The ‘Performances.log’ file records the amount of time (in nanoseconds) used by each op-
erator. It requires disk space of +/- 1 Kb per iteration of the heuristic.

Output label and directory

Viewing of the analyses results can be done in the MetaPIGA graphical interface. However, all re-
sults are also written on disk for later retrieval, viewing and manipulation. When a MetaPIGA
search is started, a result directory (named ‘MetaPIGA results’) is generated in your home directory
(Mac OS X & Linux) or in the ‘My documents’ folder (Windows). When you launch an analysis,
the results will be automatically saved in a folder named with its ‘label’ (which is, by default, the
name of the nexus file minus the “nex” extension, see Fig. 19) followed by the date (year-month-
day) followed by the time (hour_min_sec) at which the search was started. This allows for easy dif-
ferentiation of analyses performed at different times on the same dataset. For example, the result
folder “ranoidea_1b - 2010-06-09 - 17_16_16" includes the result files for the analysis of the
“ranoidea_1b.nex” data set started on June 9, 2010 at 5:16:16PM.

At the end of the search, the result folder contains the file Results.nex, i.e., a text file including:

= A MetaPIGA block corresponding to the search parameters;
= The data set;
= A tree block with the result trees, i.e.:
* Either (if replicates have not been performed):
e The best tree found (among all P*I trees) named appropriately (e.g., ‘TREE
rana_~_2010~06~09_~_17 _16_16_~_Genetic_algorithm_best_solution’)
e The best tree, of each of the P populations, named appropriately (e.g., ‘TREE
rana_~_2010~06~09_~_17_16_16_~_Best_individual_of _population_0")
* Or (if replicates have been performed):
e The consensus tree (among all replicates) named appropriately (e.g., ‘TREE
rana_~_2010~06~09_~_17 _16_16_~_Consensus_tree_~_200_replicates’)
* Then, for each replicate:
- The best tree found (among all P*[ trees) named appropriately (e.g., TREE
rana_~_2010~06~09_~_17_16_16_~_Genetic_algorithm_best_solution_[Rep_8]
- The best tree, of each of the P populations, named appropriately (e.g., ‘TREE
rana_~_2010~06~09_~_17_16_16_~_Best_individual_of population_0_[Rep_8]’)

If replicates have been performed, the result folder will also contain a text file ‘ConsensusTree.tre’
with the consensus tree among replicates. That tree is automatically updated in the run directory
after each replicate. Hence, if a crash or power cut occurs, the latest consensus tree (summariz-
ing all replicates that accumulated before the cut) can be loaded and visualized in MetaPIGA
after restarting. As the name of the tree includes the number of replicates, you will know when the
cut occurred.

As the consensus tree file is in Newick format, it can also be loaded in tree viewing softwares
such as FigTree (http://tree.bio.ed.ac.uk/software/figtree/) or TreeView
(http://taxonomy.zoology.gla.ac.uk/rod/treeview.html).

If log files have been requested (see above), they will be printed either in the results folder or in cor-
responding replicates subfolders.

5.4.6. Exiting the Settings Window

Once all settings have been chosen by the user for the ‘Heuristic’, ‘Evaluation Criterion’, ‘Starting
Tree(s)’, ‘Operators’, and ‘Miscellaneous’ tabs and the OK button has been hit, the Settings win-
dow closes and the main (entry) window is updated with the new settings listed in the upper-right
window. The user can go back to the setting window at anytime for changing any parameter.
Switching to another dataset in the left window and modifying the settings for that dataset does not
affect the settings associates to the other datasets.
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5.5. [R] The Run window 2RO @K & ®%ww @

The search is launched by clicking on the

‘[R] Run heuristic search’ button (or by selecting in the menu: ‘Search’ => ‘Run’). Once the
starting trees have been generated (this can take time), the user can follow the ongoing search by
looking at the lower left panel of the run window which displays graphical information specific to
the chosen heuristic method. For example, figure 20 shows the running window for a MetaGA
search with replicates, 4 populations, and stopping rules as indicated in figure 19. The lower-left
panel indicates the likelihood progression of each of the populations (the best tree likelihood in each
population is indicated) as well as which replicate is ongoing (rep 71). If you set replicates paralle-
lization to >1 (see red frame in Fig. 19), tabs give access to the graphs corresponding to each CPU
core (core number 2 is selected in Fig. 20; red arrow).

When using the Stochastic Hill Climbing (HC) or the simple Genetic Algorithm (GA), the
lower-left panel displays the likelihood progression of either the current tree (for stochastic HC) or
of the best tree in the single population of trees (for the GA). When using the SSA, it indicates the
progression of both the ‘temperature’ and of the likelihood. During a random-restart Hill Climbing,
the graphical interface indicates the likelihood of the overall best solution (green line), the best so-
lution of the current restart (yellow curve), and the starting tree of each restart (red line). Magenta
and blue vertical lines indicate new restarts and replicates, respectively.

Corel ~Core2 | Core3 Core4d

Progess : job finish Time left before stopping : No time stop
Negative likelihood progression in current replicate 1 (Inter-generation MRE of 0%)
[ Best solution : 5 747.3626 _| Population 0 : 5 749.956 Population 1: 5 747.3626

. Population 2 : 5 759.0359 _ Population 3 : 5 751.9232 . Starting tree (best) : 5 932.7867

334 Mb i Replicates done 113/10000 CLOSE ) “Inter- icates MRE: 0. E

¢ Fig. 20: The run window when replicates have been requested under the MetaGA heuristic. The best tree likelihood
. in each population is indicated

MetaPIGA 3.0 manual ‘!m “p31



In parallel with the likelihood progression displayed in the lower-left panel, the right panel
displays information on the current inferred phylogeny. When performing a single search (i.e.,
without replicates) the tree displayed is the current best tree. When performing replicates (as in Fig.
20), the right panel shows the current consensus tree (and corresponding frequencies of internal
branches) among all replicates accumulated thus far. Hence, the right panel of the run window al-
lows the user to observe, on the fly, the progression of the phylogeny inference or (when using the
metaGA) the progression of posterior probabilities of branches. In both cases, the user can switch
between phylogram and cladogram (blue arrow in Fig. 20). The current values of the inter-
generations (=intra-replicate) MRE and inter-replicate MRE (see ‘stopping rules’ above) are also
indicated (red frames in Fig. 20).

Once the search is completed, a window will pop up reminding you that all results (best trees
and consensus tree) have been saved in your result folder, but will also propose you to send ‘All
best trees’ or the ‘Consensus tree only’ to the ‘Tree Viewer’ (see section 5.6 below) for further ma-
nipulations (rerooting, exporting, changing substitution model and further optimizing model pa-
rameters, reconstruction of ancestral states, etc).

When using the XtremWeb-CH Grid, the run window shows the status of the workers:
queued, waiting, processing, completed, killed, or in error (see Fig. 21 for details). Workers with the
status ‘complete’ have already sent their results back to your local machine. To use the XtremWeb
Grid, please, refer to the following web site:
http://www xtremwebch.net/mediawiki/index.php/How_use

| _|Queuen: 9767 @ wartinG: 131 []READY: 44 | PROCESSING: 48 [ comPleTE: 9 [ikiep: o [ ERROR: 1
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Fig. 21: The ‘Run’window when using a XWCH grid. Status of worker are color-coded. A white box indicates that
¢ the replicate is waiting to be submitted to the grid whereas a gray box means that the replicate is waiting for an

. available worker. A blue box indicates that the worker is selected will start the analysis. A yellow box indicates that
. the replicate is running. A green box indicates that the replicate is completed and successfully retrieved from the
grid. Finally, a red box means that MetaPIGA cannot retrieve the result or that the worker is not responding (error
replicates are not used and have no effect on your analysis). Replicates stopped by the user are indicated with a
black box (‘killed’).

MetaPIGA 3.0 manual ‘!{—' “p32


http://www.xtremwebch.net/mediawiki/index.php/How_use
http://www.xtremwebch.net/mediawiki/index.php/How_use

5.6. [T] The tree viewer

5.6.1. Viewing and evaluating trees
The Tree Viewer is opened by clicking on the

‘[T] Tree viewer’ button (or by selecting in the menu: “Tools’ => ‘Tree viewer’). Trees can be
saved in the ‘Tree viewer’ either at the end of a search or by importing trees from files. The user can
even type (or copy-paste) a tree in Newick format in the lower left panel (red frame in Fig. 22), give
it a name and add it to the TreeViewer’s list of trees. The Tree viewer allows to display, rename, or
remove any of these trees at any time. The ‘Clear list’ button delete all trees from the Tree viewer.
Buttons at the bottom of the right panel allow to display the selected tree in various styles (rectan-
gular, triangular, circular, phylogram), and show/hide its nodes’ numbers or its branch lengths.
Other buttons allow rerooting a tree at any node, and save or print one or several selected tree(s).
The upper right panel indicates the parameters of the model (for each partition, if any) and the cor-
responding likelihood (yellow oval; Fig.22) of the selected tree. Obviously, for computing a likeli-
hood, every tree must be associated to a dataset, hence, the ‘Tree Viewer’ only lists the trees that are
relevant to the active dataset. The latter can be selected either in the ‘Current dataset’ scroll down
list (Fig. 23) or in the MetaPIGA main window (Fig. 2 and 10). This allows the user to easily man-
age trees generated with different datasets.

Note: Several trees can be simultaneously selected from the list by using ‘command click’ and/or ‘shift-click’.

This allows removing several trees simultaneously. On the other hand, all other commands (model change,

printing, rooting, ancestral state reconstruction, etc.) will affect only the tree highest in the list of selected trees.

Tree viewer

Add tree from file

Clear list

Current dataset

012x898 - Primate

Rename

Remove

Available trees

Consensus_tree_113_replicates a

012x898 - Primate - 2011-06-13 - 00_34_56 - Consensus pruning best solution_Rep_3
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 0_Rep_3
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 2_Rep_3
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 3_Rep_3
012x898 - Primate - 2011-06-13 - 00_34_56 - Consensus pruning best solution_Rep_1
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 1_Rep_1
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 2_Rep_1
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 3_Rep_1
012x898 - Primate - 2011-06-13 - 00_34_56 - Consensus pruning best solution_Rep_2
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 1_Rep_2
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 2_Rep_2
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 3_Rep_2
012x898 - Primate - 2011-06-13 - 00_34_56 - Consensus pruning best solution_Rep_4
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 0_Rep_4
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Tree Name ([ Addto list )

Tree in Newick format

N
/

:\> [+] Show ancestral states recopstfuction ] ; f f / \\ \\
V Show/hide /| [save’selected ) Print
Rectangular cladogram node tree(s) to disk | selected
Triangular cladogram Phylogram number [ oo oot tree(s)

export selected

Circular cladogram Show/hide branch lengths  tree(s) as images

Fig. 22: The MetaPIGA tree viewer with one tree selected in the list. Red arrow: the ‘Model’ button gives access to a
window (Fig. 23) for optimization of parameters and/or branch lengths and re-computation of the corresponding
Likelihood under any substitution model. Green arrow: button giving access to the ancestral state reconstruction
panel (Fig. 24).
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selected tree

Clicking on the “Model’ button in the ‘Tree- o, Evaluation settings

Viewer’ (red arrow; Fig. 22), opens the ‘Evaluation é Rate matrix Nucleotide substitution
settings’ window (Fig. 23) that allows (for the se- = |3 o temnontanseson S Qfg"
lected tree) to (re-)optimize model parameters and/ 3 O HKY8S

Starting values

or branch lengths and re-compute the correspond- NG EGNEE  | Rate heterogeneity
1

. . . . = 5.4. 1 () None
ing likelihood under any settings of model parame- I I I || @ oiscrece Gamma
T T (S50 = subsets | 4(3)

ters. Note that, although parameters can be manu-
ally set for each partition separately by using the e
vertical tabs (Fig. 23), clicking on the ‘Optimize (_Optimize parameters ) 'ga:::': e
model parameters’ or ‘Optimize branch lengths’ O p-invariant
button will perform joint optimization for all parti-
tions. Once the model setting have been confirmed
by clicking the ‘OK’ button, the upper-right panel
of the ‘TreeViewer’ (Fig. 22), and the tree itself,
will be updated with the new parameter values.

shape [0.57533¢
Among-partition rate : 0.95

MY_OTHER_CHARSET

(" Optimize branch lengths )

| 'REMAINING

oK ) ( CANCEL )
S———— S———

Fig. 23: The evaluation settings window.

5.6.2. Ancestral states reconstruction

During phylogeny inference under ML, the probabilities of all possible character states at all nodes
are computed for all characters. This provides means for reconstructing ancestral sequences both in
silico and in the laboratory (e.g., [10-14]). Clicking on the button indicated with a green arrow in
Fig. 22 gives access to the ancestral state reconstruction panel of the ‘TreeViewer’. Simply select an
internal node on the tree for viewing its corresponding ancestral sequence. Various buttons allow for
different display styles and for exporting the ancestral sequence(s) (and the corresponding statistics)
either of the selected node or of all internal nodes of the tree. The ancestral sequence reconstruction
we implemented is Empirical Bayes [49].

000 Tree viewer

p

Add tree from file Clear list ) TREE. with G listribution (4

Current dataset 012x898 - Primate B3

e

Rename ) Remove Model

Available trees

ol Memes -
012x898 - Primate - 2011-06-13 - 00_34_56 - Consensus pruning best solution_Rep_3
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 0_Rep_3
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 2_Rep_3
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 3_Rep_3
012x898 - Primate - 2011-06-13 - 00_34_56 - Consensus pruning best solution_Rep_1
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 1_Rep_1
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 2_Rep_1
012x898 - Primate - 2011-06-13 - 00_34_56 - Best individual of population 3_Rep_1
012x898 - Primate - 2011-06-13 - 00_34_56 - Consensus pruning best solution_Rep_2

N17u802  Drimara  IN11 . NE 12 NN 24 & Bact indiidial af nanulatian 1 Dan 2

Tree Name ( Add to list )

Tree in Newick format

I#NUE .
REpE@Y e

[-]1 Hide ancestral states reconstruction [-]

yonding nuc

A G T (for each olored bar represents the cL% of the corre de cL%. Nucleotide w C €
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Fig. 24: The ancestral state reconstruction panel displays the conditional likelihood proportions of
each state at each site for the node 6, directly selected on the tree in the upper-right panel. The Bland
buttons allow exporting to disk a text file with the ancestral states of the selected node or of all

nodes, respectively. Use the m and HH buttons to switch between a view where bars of the

¢ histogram, for each character, are in front of each others (with the column of lowest likelihood

i proportion in the front) and a stacked histogram. The sequence indicated at the top corresponds to the
most likely ancestral sequence.
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5.7. Building and running batch | [U] Duplicate selected file  [O] Associate settings
files with the GUI 2o A_;B‘ %56 —

1S] Save all files
|[n a]Nexus batch [R] Run batch

MetaPIGA supports the use of batch files that can

be either written manually (see next Section) or

generated using tools available in the GUI: datasets

and their settings can be duplicated, settings can be “stamped” from one dataset to another, and
multiple combinations of datasets and settings can be saved in a batch file that can be run either in
the GUI (with various graphical information on search progress) or using command line.

5.7.1. Transferring analysis settings among datasets
Batch files are particularly useful for running different datasets with the same analysis settings.
Imagine for example that you have opened 4 datasets in MetaPIGA (‘012x898 - Primate’, ‘PRO-
TEINS - 36x958°, ‘ranoidea_Ib’, and ‘055x1314 - mp1’) and that you have chosen all settings (us-
ing the various tabs in the Analysis
Settings window, see section 54)

for the dataset ranoidea_1b. Now, ﬂ’&‘\@
as shown in figure 25, you can
transfer these settings to any com- g ‘ :
bination of other opened datasets by = [ERENCREEE jsers/miche i
(i) choosing the source dataset, then | &= ; zarion a0 K
(ii) clicking on the /O] Associate = [N ( iv ove 1
settings’ button (or by selecting S
in the menu: ‘Batch’ => ‘Associate Fig. 25: Transferring settings from one dataset to other dataset(s).
selected dataset analysis SEItINGS’),

then (iii) selecting the dataset(s)

you want to transfer the settings to, and (iv) click on the ‘Associate’ button.

v The batch can then be run in the GUI by clicking on the /TR] Run batch’ button [

lecting in the menu: ‘Batch’=> ‘Run all datasets in a batch’)
v Alternatively, the user can save the batch by clicking on the ‘Save all files in a Nexus batch’

button 2] (or by selecting in the menu: ‘Batch’=> ‘Save all datasets in a batch Nexus file’). This
file can be run in command line (e.g., on a distant server) or re-imported in MetaPIGA and run
through the GUI.

©

£ @l%|| @

OES

(or by se-

5.7.2. Duplicating datasets for batch files

Batch files are equally useful for running sequentially a single data set under multiple different set-
tings: for example analyzing your favorite dataset with different substitution models or with differ-
ent heuristics. First make as many duplicates of your dataset (called ‘012x898 - Primate’ in Fig. 26)

as you wish by clicking on the ‘/U] Duplicate selected dataset’ button (or by selecting in the
menu: ‘Batch’ => ‘Duplicate selected dataset’). Then, select a duplicate and change the settings as
required (in the ‘Analysis settings’ window). In this way, you can for example run a batch file that
will sequentially run the ‘Primate’, ‘Primate_I’, ‘Primate_2’, and ‘Primate_3’ datasets with, re-
spectively the JC, K2P, HKY, and GTR substitution models. Note that, when duplicating a file, the
settings listed in the ‘Dataset settings’ window (outgroup taxa, charsets, partitions, etc.) are dupli-
cated as well.
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Use this slider to change the selected dataset priority in a batch run EEr o R i ]

Metapiga 2.1

distribution is ( of invariant sites

. Fig. 26: (a) Duplicating datasets and (b) the parameter panel indicates the modified settings as chosen in the /4]

¢ Analysis Settings’ window (here, we have changed the substitution model to K2P with rate heterogeneity (and

i estimated starting parameters) for the ‘Primate 1’ duplicate whereas the initial settings for the ‘Primate’ dataset is
: JO).

Notes: when running a batch file:

v The run window is simplified (in comparison to what is described above in Section 5.5). Beside basic statistics on
the current run, the batch run window displays (in two separate panels) the log file information on the current run
and on the overall batch. Two buttons allow for stopping either the current run or the entire batch of runs.

The result trees of all replicates of all runs are automatically added to the ‘TreeViewer’.

<

5.8. Building batch files manually

Instead of using the GUI, you can manually build Nexus batch files. As an example, the file below
will run the single dataset of 15 taxa and 100 characters first with the JC model then with the GTR
model + gamma-distributed rate heterogeneity.

The full list of MetaPIGA commands for manually building batch files are available in the Appen-
dix 1.

Check the end of section 5.2 for instructions on how running MetaPIGA in command line (this
is particularly useful if you want to send jobs to a distant server).

#NEXUS
[Metapiga - LANE (Laboratory of Artificial and Natural Evolution, University of Geneva)]

BEGIN BATCH;

RUN LABEL=15-100 DATA=data_1 PARAM=param 1;
RUN LABEL=15-100_ 1 DATA=data_1 PARAM=param 2;
END;

BEGIN METAPIGA;

[ BATCHLABEL=param 1]

HEURISTIC CP CONSENSUS=STOCHASTIC OPERATOR=SUPERVISED NPOP=4 NIND=4 TOLERANCE=0.05
HYBRIDIZATION=0.1 SELECTION=IMPROVE RECOMBINATION=0.1 OPERATORAPPLIEDTO=IND NCORE=1;
EVALUATION MODEL=JC DISTRIBUTION=NONE PINV=0.0;

OPTIMIZATION ENDONLY ALGO=GA TARGET{ BL };

STARTINGTREE GENERATION=LNJ(0.1)

MODEL=JC DISTRIBUTION=NONE PINV=0.0;
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OPERATORS { TXS(2) STS(2) TBR NNI SPR BLM } SELECTION=RANDOM;

SETTINGS LABEL=15-100;

STOPAFTER AUTO=200 CONSENSUS MRE=0.03 GENERATION=5 INTERVAL=10;
REPLICATES AUTOSTOP=MRE(0.05) RMIN=100 RMAX=10000 INTERVAL=10 PARALLEL=1;
OUTGROUP { ANABAENA SP2 };

END;

BEGIN METAPIGA;

[ BATCHLABEL=param 2]

HEURISTIC CP CONSENSUS=STOCHASTIC OPERATOR=SUPERVISED NPOP=4 NIND=4 TOLERANCE=0.05
HYBRIDIZATION=0.1 SELECTION=IMPROVE RECOMBINATION=0.1 OPERATORAPPLIEDTO=IND NCORE=1;
EVALUATION

MODEL=GTR RATEPARAM{ A(0.5) B(0.5) C(0.5) D(0.5) E(0.5)} DISTRIBUTION=GAMMA (4)
DISTSHAPE=1.0 PINV=0.0;

OPTIMIZATION ENDONLY ALGO=GA TARGET{ BL R GAMMA };

STARTINGTREE GENERATION=LNJ(0.1) MODEL=JC DISTRIBUTION=NONE PINV=0.0;

OPERATORS { TXS(2) STS(2) TBR NNI SPR BLM RPM(ALL) GDM } SELECTION=RANDOM;
SETTINGS LABEL=15-100_1;

STOPAFTER AUTO=200 CONSENSUS MRE=0.03 GENERATION=5 INTERVAL=10;

REPLICATES AUTOSTOP=MRE(0.05) RMIN=100 RMAX=10000 INTERVAL=10 PARALLEL=1;

OUTGROUP { ANABAENA SP2 };

END;

BEGIN DATA;

[BATCHLABEL=data_1]

DIMENSIONS NTAX=15 NCHAR=100;

FORMAT DATATYPE=DNA MISSING=? GAP=- SYMBOLS="01" LABELS ITEMS=STATES STATESFORMAT-
=STATESPRESENT NOTOKENS ;

MATRIX
Anabaena_sp2 CAAGATTACAGACTAACTTATTACACACCTGATTACACACCTAAAGATACAGATATTCTGGCGGCATTCCGTGTTACACCCCAGCCCGGAGTTCCCTTTG
Chara_conniv AAAGATTACAGATTAACTTACTATACTCCTGAGTATAAAACTAAAGATACTGACATTTTAGCTGCATTTCGTGTAACTCCACAACCTGGCGTTCCACCTG
Chlor_ell AAAGACTACCGTTTAACTTACTATACTCCTGATTACCAACCAAAAGACACTGATATTCTTGCAGCGTTCCGTATGACTCCTCAACCAGGTGTTCCACCAG
Volvox_ro AAAGATTATCGTTTAACATACTACACACCTGACTATGTAGTAAAAGACACTGACATCTTAGCAGCATTTCGTATGACTCCACAACCAGGTGTTCCACCTG
Sirogonium_melanosp AAAGATTACAGACTTACATATTACACTCCTGAATATGAGACCAAAGAAACTGATATTTTAGCTGCATTCCGCATGACTCCTCAGCCTGGAGTACCACCTG
Zygnema_peliosp AAAGATTACAGACTTACCTACTATACTCCTGATTATGAGACCAAAGAAACCGACATTTTAGCTGCATTCCGCATGACTCCTCAAGCTGGAGTTCCACCAG
Conocephalum 92 AAAGATTATCGATTAACTTATTATACTCCGGATTATGAAACTAAAGATACGGATATTTTAGCAGCATTTAGAATGACTCCTCAGCCTGGGGTACCAGCAG
Dumortiera 100 AAAGATTATCGATTAACTTATTACACTCCGGATTATGATACCAAGGATACAGATATTTTGGCAGCCTTTAGAATGACTCCTCAGCCTGGAGTACCAGCAG
Marchantia_5 AAAGATTATCGATTAACTTATTACACTCCGGATTATGAGACCAAGGATACGGATATTTTAGCAGCATTTAGAATGACTCCTCAGCCTGGAGTTCCAGCGG
Bazzania_jm AAAGATTATAGATTAACCTATTATACGCCTGAATATGAGACCAAAGAGACAGATATTTTGGCAGCATTTCGTATGACTCCCCAACCGGGAGTACCACCTG
Metzgeria_3 AAAGATTACAGATTAAATTATTACACTCCAGATTATGAAACTAAAGATACAGATATTCTAGCAGCATTTCGTATGACCCCTCAGCCTGGAGTACCAGAAG
Porella 4 AAAGATTATAGATCAACTTATTATACTCCCGACTATGAAACAAAGGAGACAGATATTTTAGCAGCATTTCGTATGACTCCTCAACCTGGAGTACCAGAAC
Anthoceros_6 AAAGATTATAGATTAACCCATTATACCCCTGATTACGAGACCAAGGATACTGATATTTTGGCAGCGTCTTGAATGACTCCTTAACCAGGGGTGCCACCTG
Tetraphis_9 22222222 2AGATTAACTTATTACACTCCAGATTATGAGACCAAAGAGACCGATATTTTAGCAGCATTTCGAATGACTCCTCAACCCGGAGTACCACCTG
Sphagnum_jm AAAGATTACAGGTTGACTTATTACACCCCGGAGTATGCTGTCAAAGATACCGACATTTTGGCAGCATTTCGAATGACTCCTCAACCTGGAGTACCACCCG
.

r

END;
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5.9. The ‘Tools’ Menu

In addition to functionalities discussed above (the ‘TreeViewer’, section 5.6.1; the ‘Ancestral states
reconstruction’ panel, section 5.6.2; and the ‘Memory settings’ window, Fig. 1a), the ‘Tools’ menu
(Fig. 27a) also gives access to a ‘Tree Generator’, a ‘Consensus Tree’ builder, and a tool for com-
puting pairwise distances. The ‘Tree Generator’ (Fig. 27b) allows for the generation of the NJ tree
or any number of Loose Neighbor Joining (LNJ; section 5.4.3) or random trees. The trees generated
are automatically transferred to the ‘TreeViewer’ under appropriate names (e.g., NJ, LNJ_1, LNJ_2,
RANDOM_1,RANDOM_2).

a b.
eno Generate tree using dataset 012x898 - Primate
Tree generation Distance ma [Distribution Invariable sites
() Neighbor Joining O GTR ® None ® None
: @ Loose Neighbor Joining \:/ TN93 \_/ Discrete Gamma v P-Invariant
Range 10/ % O HKY8S ape > t %
Tools N5 (O True Random ) K2P 1po

2 Tree Viewer £ ®c
[& Tree Generator
[}l Ancestral states reconstruction

[& Build consensus tree Outgroup
. c t d t Use dataset settings to change outgroup and excluded taxa. No outgroup is currently defined.
ompute distances
i 5 -~ . r (4]
8 Memory settings #M Generate 100 7] trees

Fig. 27: (a) The Tools menu; (b), the Tree Generator.

In the ‘Consensus tree builder’ (Fig. 28a), trees in the left panel (corresponding to all trees from the
‘TreeViewer’) can be moved to the right panel for building a majority-rule consensus tree (with fre-
quencies of clades) which is then automatically added to the TreeViewer under a chosen name
(“my_consensus_tree” in Fig. 28a). The pairwise distances tool (Fig. 28b) allows for computing
pairwise distances (among sequences of the active dataset) in the form of absolute numbers of dif-
ferences or various distances: uncorrected (none) or corrected following a nucleotide or amino-acid
or Codon substitution model with or without rate heterogeneity. Distances can be exported to a text
file for spreadsheet applications such as Excel.

0o Compute distances of dataset 012x898 - Primate

( Compute ) ( Saveto file

@ Distances
Distance correction
O cr
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O kap

®c
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000 Consensus tree builder

Use the (_ TreeViewer ) to load trees and then

Rate heterogeneity

® None

update ) Dataset 012x898 - Primate ]

Available trees (458 trees) Tree name ' my_consensus. kree A
= = (U Discrete Gamma

012x898 - Primate - 2011-06-13 - 19_00_2

012x898 - Primate - 2011-06-13 - 19_00_2 Consensus (5 trees)

012x898 - Primate - 2011-06-13 - 19_00_2 012x898 - Primate - 2011-06-13 - 19_00_20
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5.10. Troubleshooting

Please, don’t hesitate to contact us (Dorde.Grbic@unige.ch or michel.milinkovitch@unige.ch)
if you encounter problems or bugs. We are also open to suggestions for improving the software.

A few problems that can arise when using MetaPIGA are listed below.

Launching

When launching, MetaPIGA checks for the availability of updates (unless you have used the argu-
ment [noupdate] in command line). If you are connected to the internet, and there is no update to
download, MetaPIGA will simply proceed with launching. If there is an update available,
MetaPIGA will request your authorization to perform that update. If you are not correctly connected
to the internet when launching the software, MetaPIGA will simply proceed with launching.

Java errors at launch

v The Java 1.6 Virtual Machine (VM) must be installed on your computer for running MetaPIGA.
If you only have earlier Java version(s) installed, your computer will complain, e.g., with an er-
ror like that shown in Fig. 29. The Java 1.6 VM can be installed for Windows and Linux at
http://java.com/en/download/manual.jsp. For Mac OSX, simply run the ‘Software Update’ fea-
ture available on the ‘Apple menu’. To check, on your Mac, if Java 6 is installed and active, sim-
ply launch the ‘Terminal.app’ available in the “Utilities” sub-folder of the “Applications”
folder. Then check your Java version by typing ‘java -version’, and pressing ENTER. If you are
using the Snow Leopard Mac OS (OS X 10.6), you can check the version(s) of Java installed on
your machine by launching the ‘Java Preferences.app’ available in the “Utilities” sub-folder of
the “Applications” folder. Make sure that Java 6 (or later) is in the list AND active (i.e., marked
as in Fig. 30). You DON’T need to remove earlier Java versions (that might be required for older
softwares). Note that if your Mac OS is older than 10.5, it will not support Java 1.6 ... hence, you
will not be able to run MetaPIGA.

e 00 Startup Error 800 Java Preferences
v
(‘)j An error has occurred during startup: [General Security ~ Network  Advanced !

- . p - . java Applet Plugin
java.lang.UnsupportedClassVersionError: Bad version number in .class file s B g

at java.lang.ClassLoader.defineClass 1(Native Method) Run applets: () In their own process
at java.lang.ClassLoader.defineClass(ClassLoader.java:676)

at java.security.SecureClassLoader.defineClass(SecureClassLoac|
at java.net.URLClassLoader.defineClass(URLClassLoader.java:26
at java.net.URLClassLoader.access$100(URLClassLoader.java:56

@ Within the browser process
Default, more compatible

64-bit Web browsers use this order to determine the first

at java.net.URLClassLoader$ 1.run(URLClassLoader.java:195) ™ Java st 6 e I 0 0 UEC 1 T
at java.security.AccessController.doPrivileged(Native Method) ™ Java SE 6 32-bit
at java.net.URLClassLoader.findClass(URLClassLoader.java:188) ———
at java.lang.ClassLoader.loadClass(ClassLoader.java:317) Options (_Restore Defaults )
at sun.misc.Launcher$AppClassLoader.loadClass(Launcher.java Drag to change the preferred order
at java.lang.ClassLoader.loadClass(ClassLoader.java:307) 4
at java.lang.ClassLoader.loadClass(ClassLoader.java:252) X Java Applications
= — < »
—bit Java applications, Web Start applications, and command line
(k) ke S| i oo drmine ot st
(" Restore Defaults )
.
Fig. 29: Error message at launch due to the absence T e e -
of a Java 1.6 (or later) VM.
Changes take effect in browsers and Java applications the next time you open them.
Fig. 30: The Java Preferences utility on Mac OS X.

v 1f MetaPIGA crashes at launch, it can also be due to a lack of memory. Try closing other applica-
tions, or change the maximum amount of memory allowed to MetaPIGA: in the file
‘mp2_console.vmoptions’ (that you can find at the root of the MetaPIGA folder, i.e., where the
program is installed) , set the Xmx value (and not the Xms value) to a lower value (expressed in
megabytes; this value must be a multiple of 256). Note however that, to avoid problems, we
made the installer allocate to MetaPIGA half of the memory available on your running machine.
This should insure MetaPIGA to launch properly, even if other programs are running. Once
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MetaPIGA has launched, the ‘memory settings’ (in the ‘Tools’ menu of MetaPIGA) allows
changing the amount of memory allocated to MetaPIGA. The maximum value available in
‘memory settings’is 1536 Mb on a 32-bit system (i.e., the maximum allowed by java on such a
system) ... even if the computer is equipped with more than 2Go of RAM. On the other hand, the
maximum value available on a 64-bit system (i.e., most of modern machines) can be much
higher than 1536 Mb but is constrained to the amount of memory available on that machine mi-
nus 512Mb.

Recovering results if a crash occurs

A ‘Results.nex’ file is written to the Results directory (see end of section 5.4.5) when the search is
completed. On the other hand, the ‘ConsensusTree.tre’ file is automatically updated in the run di-
rectory during the search. Hence, if a crash occurs, for example after a significant running time in-
volving a number of replicates, the ‘ConsensusTree.tre’ file (summarizing all replicates that accu-
mulated before the crash) can be loaded and visualized in MetaPIGA after restarting. As the name
of the tree includes the number of replicates, you will know when the crash occurred. As the con-
sensus tree file is in Newick format, it can also be loaded in tree viewing softwares such as:
-FigTree (http://tree bio.ed.ac.uk/software/figtree/)

-TreeView (http://taxonomy.zoology.gla.ac.uk/rod/treeview.html).

Others

v When negative eigenvalues are encountered under GTR, an error message is generated and the
search crashes.

v Sequences too dissimilar (>0.75 for DNA sequences, >0.95 for Protein sequences, and > 0.5 for
standard binary data) can cause an error when computing distance matrices. The data quality
control button (i.e., ‘scissor’ button, section 5.2.2) and the ‘check for saturation’ function in the
‘Dataset’ menu allow avoiding that problem.
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Third party libraries: MetaPIGA makes use of the following third party libraries (source code
available through the corresponding links):
* The CERN Colt Scientific library 1.2.0 for pseudorandom number generation and statistics:
http://acs 1bl.gov/software/colt/
e JAMA : A Java Matrix Package for matrix manipulations and eigen values decomposition:
http://math.nist.gov/javanumerics/jama/
* The BioJava library to parse NEXUS files: http://www.biojava.org/
BioJava: an Open-Source Framework for Bioinformatics
R.C.G. Holland; T. Down; M. Pocock; A. Prli¢; D. Huen; K. James; S. Foisy; A. Drdger; A.
Yates; M. Heuer; M .J. Schreiber
Bioinformatics (2008) 24 (18): 2096-2097; doi: 10.1093/bioinformatics/btn397
* The Google Collection classes library for its BiMap:
http://code.google.com/p/google-collections/
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7. Appendix 1: The MetaPIGA commands

MetaPIGA 2 requires only one thing to run: a nexus input file. This file must contain your sequence
data following the standard Nexus data structure, i.e., using data blocks (or taxa + characters
blocks). This file can be loaded and run either using the menu-driven interface (GUI) of MetaPIGA
2 or in command line.

All menus are described in detail above. However, the user can also choose to include all custom-
ized settings of MetaPIGA-2 in the Nexus input file and send it to the program for running without
the use of the interface. This is particularly useful for performing unsupervised successive multiple
long runs (batch files). In that case, the customized settings of MetaPIGA must be included in the
Nexus input file in the form of a ‘metapiga block’. The structure of this block is described hereaf-
ter. Note that, if you don’t like typing the parameter settings yourself, you can use the MetaPIGA-2
user interface to generate, save, and run batch files.

Conventions:
When a parameter is associated with information between round parentheses ( ), there must be
no blank before or within the parentheses. For example:
DISTRIBUTION = GAMMA (4)
cannot be written
DISTRIBUTION

GaMMA (4)
nor

DISTRIBUTION GaMMA ( 4 )

nor

DISTRIBUTION = Gamma ( 4 )

All parameters between squared brackets [ ] are optional and can be omitted, and MetaPIGA will
then use default values (underlined in the block description). Description of the commands is
given in the above user manual (Section 5.3: ‘Dataset settings’).

Batch files

You can easily create batch files, to run multiple analyses automatically. Batch files are nexus files
in which you can add as many data block, metapiga blocks, and tree blocks as you wish. You must
add a comment in the first line of each metapiga block in the form of a label using [BATCHLABEL =
label]. Then, create a batch block that associates each run to (i) a data block and (ii) a metapiga
block using those labels. The use of a tree block is optional.
For example, to run a given dataset with 2 different sets of parameters (the second requiring user-
defined starting trees), the batch file will look like this:
BEGIN BATCH;

RUN LaABEL='runl’ DATA=labell PaArRAM=labell;

RUN LaBEL='run2’ DATA=labell PARAM=label? TREE=label?2;
END;

BEGIN DATA; [BATCHLABEL = labell]

END;
BEGIN TREE; [BATCHLABEL = labellZ]

END;
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BATCH Block

BEGIN BATCH;
RUN LaBEL='run label’ DaTA=data block label
ParaM=metapiga block label [TrReEEs=tree block label];
Run ..

END;
METAPIGA Block
BEGIN METAPIGA;
[HEURISTIC
‘HC [RESTART = nbr of restart]
| SA [COOLINGSCHEDULE = ‘LUNDY | RP(delta) | CaucHY | BOLTZMANN | GEOM(alpha)
| Lin | TrI | Pory | Exp | LoGg | PER | SPER | TaNH | Cosu’] [LunC = Iundy c]
[LunALpHA = lundy a] [INITACCEPT = value] [FINALACCEPT = value] [DELTAL =
‘PERCENT [ (P) ] | BURNIN’] [REHEATING = 'DECREMENTS (d) | THRESHOLD (p) | NEVER’]
[CooLING = 'STEPS (steps) | SE(s,f)’] [DYNCS]
| GA [NIND = individuals] [SELECTION = ‘RANK | TOURNAMENT | REPLACEMENT[ (S) ]
| IMPROVE | KEEPBEST’ ] [RECOMBINATION = rate] [OPERATORAPPLIEDTO = ‘STEP |
IND ]
| CP [CONSENSUS = ‘STRICT | STOCHASTIC’] [OPERATOR = BLIND | SUPERVISED] [NPOP
= populations] [NIND = individuals] [TOLERANCE = tolerance] [HYBRIDIZATION
= rate] [SELECTION = ‘RANK | TOURNAMENT | REPLACEMENT[ (S)] | IMPROVE | KEEP-
BEST’ ] [RECOMBINATION = rate] [OPERATORAPPLIEDTO = ‘STEP | Pop | IND’] [NCORE
= cores]’ ;]
[EVALUATION [RATE = ‘BRANCH | TREE’] [DATATYPE=CODON CODONRANGE{Start position-

end position}] [MopeL = ‘GTR | TN93 | HKY85 | K2P | JC | GTR20 | WAG |
JTT | DAYHOFF | VT | BLOSUM62 | CPREV | MTREV | RTREV | MTMAM | POISSON

| GTR2 | ECM | GY'] [] [RaTEPARAM {param(value) ..}] [AAFREQ = ‘EMPIRICAL |
ESTIMATED’ ] [DISTRIBUTION = ‘NONE | GAMMA (subsets) | VDP(subsets)’] [DisT-
SHAPE = shape] [PINV = proportion of invariant];]

[SPECIFICPARTPARAM PARTNAME = charset—-name [RATEPARAM {param(value) ..}] [DIsT-
SHAPE = shape] [PINV = proportion of invariant];]

[OPTIMIZATION ‘NEVER | CONSENSUSTREE | ENDSEARCH | Disc(s) | StocH(p)’ [ALGO =
algorithm] [TARGET {param ..}] ;]

[ STARTINGTREE [GENERATION = ‘NJ, LNJ (range), RanpoM, GIVEN’] [MODEL = ‘GTR |
TNO93 | HKY85 | K2P | JC | GTR20 | PorssoN | GTR2 | NoNE’] [DISTRIBUTION =
‘NoNE | GAMMA (shape) | VDP (subsets)’] [PINv = invariant] [PI = ‘EQUAL |
ESTIMATED | CONSTANT' ]; ]

[OPERATORS {operator|[ (parameter)] [operator| (parameter)] ..]} [SELECTION =

‘RANDOM | ORDERED | FREQLIST’] ;]

[FREQUENCIES {operator (frequency) ..} /]

[DYNAMICFREQ DYNOPERATORS {operator ..} [DINT = interval] [DMIN = minimum fre-
quency] ;]

[SETTINGS [REMOVECOL = ‘NONE | GAP | NGap'] [DIR = ’output directory’] [LABEL
= ’run_label’] [GRID [SERVER = address] [CLIENT = id] [MopuLE = id]];]

[ STOPAFTER [STEPS = steps] [TIME = hours] [AUTO = steps [AUTOTHRESHOLD =
value]] [CoNseNsUS [MRE = error] [GENERATION = steps] [INTERVAL = steps]]
[NECESSARY {stop condition ..}];]

[REPLICATES [AUTOSTOP = ‘NoNE | MRE[ (error)]’] [RNuM = nbr rep] [RMIN =

nbr rep] [RMax = nbr rep] [INTERVAL = interval] [PARALLEL = cores]; ]

OuTtGrouP {taxa ..} /]

DELETE {taxa ..} ;]

CHARSET NAME = charset—-name SET{character-set ..} ;]

EXCLUDE {charset ..} ;]

PARTITION {charset ..} ;]

Lo {logFile ..} /]

L W e B e W |

END;
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Description of the parameters:

1. HeurisTic — By default, Metapiga uses the metaGA heuristic (i.e., a genetic algorithm with consensus pruning;
see Lemmon & Milinkovitch 2002 for details).

HC - Hill Climbing. Tree space is explored using local perturbations (of topology and/or branch lengths
and/or model parameters). New trees with improved likelihood are always accepted whereas trees with
worse score are always discarded. This is the ‘stochastic hill climbing’ heuristic. We also implement a meta-
heuristic called 'random-restart hill climbing'. When the REsTarT parameter is set to a value greater than 0,
ReEsTarT+1 hill climbings are iteratively performed, each time with a different initial tree. Among the Re-
sTAarT+1 solution trees, only the best is kept.

Note that, when choosing the ‘Neighbor Joining’ starting-tree option (see STARTINGTREE parameter), the NJ

tree will only be used for the first hill climbing, and Loose NJ trees will be generated for all restarts. Like-
wise, when choosing 'user trees' but the number of provided starting trees is smaller than REsTarT+1, LNJ

random trees will be generated for the missing starting trees. Note also that the stop conditions (see SToPAF-
TER parameter) are defined for one hill climbing. For example, when choosing 10 restarts and ‘2000 steps’
as the stop condition, 11 hill climbing of 2000 steps will be performed, but only the best scored tree, among
the 11 results, will be kept.

SA - Simulated Annealing. Starting from a single tree, tree space is explored using local perturbations (of
topology and/or branch lengths and/or model parameters). New trees with improved likelihood are always
accepted, whereas trees with worse score are accepted with a probability which is a function of both the
proportionate decrease in score and a control parameter called "temperature”. Much additional informa-
tion is available in Kirkpatrick et al., Optimization by Simulated Annealing, Science, 220, 4598, 671-680
(1983).
= ScHEDULE — The “cooling schedule” describes how the “temperature” decreases during the run.
is the temperature after decrements and is the maximum number of temperature decrements be-
fore reseting the temperature to the starting temperature (see REHEATING parameter
below).Except for the Lunpy cooling schedule, (and when it applies) are computed as follows:
where is an upper bound on the change in likelihood, is the initial and the final acceptance parame-
ters (see below).Available schedules are :
O LunNpY — The cooling schedule described by Lundy (1985).
with
being the parameter that controls the rate of cooling (its value is < 1) where is the number of
sequences, (taxa) is the number of sites, and are set between 0 and 1 (see C and ALpHA pa-
rameters below) and is the log likelihood of the neighbor joining tree. It’s the default cooling

schedule.

RP (delta) - Aratio-percent cooling schedule.
CaucHY - Fast Cauchy schedule.

BOLTZMANN — Boltzmann schedule.

GEOM (alpha) — Geometric schedule.

LiN - Linear schedule.

TRI — Triangular schedule.

PorLy - Polynomial schedule.

Exp — Transcendental (exponential) schedule.
Loe — Transcendental (logarithmic) schedule.
PER — Transcendental (periodic) schedule.

SPER — Transcendental (smoothed periodic) schedule.
TanH — Hyperbolic (tanh) schedule.

CosH — Hyperbolic (cosh) schedule.

O 0O O 0O o O o0 O O 0 o0 O o©°

= LUNC - The parameter used in the LunDY cooling schedule. You can set its value between [0,1] and
the default value is 0.5.

= LuNALPHA — The parameter used in the Lunpy cooling schedule. You can set its value between [0,1]
and the default value is 0.5.
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= INITACCEPT — It's the initial maximum probability () to accept a tree with a ‘worse’ likelihood.
Hence, it will define the starting temperature used when simulated annealing starts or when the
temperature is reset (see REHEATING below). It's a probability, chosen between [0, 1], is set to 0.7
by default. Used with all cooling schedules except Lunpy.
= FINALACCEPT — It’s the final maximum probability to accept a tree with a ‘worse’ likelihood (), so it
will define the ending temperature used when simulated annealing should end or before reseting
the temperature (see REHEATING below). It’s a probability, chosen between [0, 1], must be smaller
than INITACCEPT and is set to 0.01 by default. Only used with L1n, TRI, PoLY, ExP, LOG, PER, SPER,
HypTanH and HypCosH cooling schedules.
= DELTAL — Determines how is initialized. is used to compute the starting temperature, and is the
maximum distance between a current solution and a worse solution that could be accepted with a
probability of .
O PERCENT (p) - issettoapercentage p of the Neighbor Joining Tree log likelihood. You can
set the value of p between [0,1] and the default is 0.001 (0.1% of the NJT).
O BURNIN - Selected operators are used on the starting tree for a burn-in period of 20 appli-
cations for each operator. The maximum change in log likelihood observed during this period

is used as .
®= REHEATING — Determines under which condition the temperature is reset to the initial starting
temperature.

O NEVER — Temperature is never reset, but this option can only be selected with Lunpy, RP,
CaucHY, BoLTZMANN and GEoMETRIC cooling schedules.

O DECREMENTS (d) — Temperature is reset when it has decreased d times. It’s the default Re-
HEATING option, usable with all cooling schedules.

O THRESHOLD (p) — Temperature is reset when it attains a threshold equal to Note that must
be smaller than 1 and sufficiently small (0.001 is the default value). This REEEATING option
can only be used with Lunpy, RP, CAUCHY, BOLTZMANN and GEOMETRIC cooling schedules.

®= CooLING - Establishes the number of times a tree is modified before the temperature is decreased.
You can choose between 2 cooling types:

O STEPS (steps) — Stay at the same temperature for a given number of steps.

O SF(s,f) — Lowerthe temperature after s successes or 1 failures, whichever comes first.
Successes are tree modifications that improve the likelihood and failures are those that do
not. This CooLING is used by default, with s =10 and £ =100.

e GA - Genetic Algorithm. At each step (generation) of the heuristic, each individual of a population of
trees is mutated using the selected operators. Death / survival of individuals is controlled using a selection
scheme.

= NIND — The number of individuals (trees) within the population (set). Set to 8 by default.
= SELECTION — The method used to control death / survival of individuals :

O RaNk — We implement a rank selection similar to that described in (Lewis 1998, Mol. Biol.
Evol. 15, 277-283). The individual having the highest InL is automatically allowed to leave
k=0.25*N1InD offspring (i.e., copies of itself) in the next generation. Then, each individual is
assigned a probability p of leaving an offspring as a function of its position in a list in which
individuals are ranked by their score. The probability p for the ith individual of leaving an off-
spring to the next generation is equal to:

O TOURNAMENT — Two individuals are drawn randomly from the population of n individuals, and
one offspring is produced from the individual with higher score. Both trees are then placed
back into the mating population, and the whole process is repeated until n offspring have
been generated. This is the default selection method.

O REPLACEMENT — Two individuals are drawn randomly from the population of n individuals
and two copies of the better individual are returned to the mating pool (parents are dis-
carded). The process is repeated sn times, where s is the strength of the selection (1.0 by de-
fault), then the offspring population is generated as an exact copy of the post-selection par-
ent population.

O IMPROVE — Only those individuals that have scores better than that of the best tree from the
previous generation are kept. Each individual that fails this test is discarded and replaced by a
copy of the current best individual.
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O KEeEPBEST — Only the best individual of each population is kept, others are replaced by a
copy of it.

= RECOMBINATION — Each counter-selected sub-optimal individual has a probability p (between [0, 1]
and set to 0.1 by default) to recombine with a better individual in the population. Recombination is
performed by exchanging subtrees defined by one of the identical taxa partitions in the two parental
trees (i.e., one internal branch that defines subtrees including the same taxa but with potentially
different sub-topologies). If no common branch exists, the offspring is defined as a copy of the best
individual. A recombination event can be viewed as a large number of simultaneous topological mu-
tations. The exact procedure depends on the selection scheme:

O Rank — Recombination is not available under that selection scheme.

O TourNaMENT — With a probability p, the offspring set after a tournament is not a copy the
individual with higher score but a recombination between the two trees that have been ini-
tially drawn for tournament.

O REPLACEMENT — With a probability p, only one (instead of two) copy of the better individual
is returned to the mating pool. The second individual returned is a recombination between
the two trees that have been initially drawn.

O IMPROVE — Each individual that does not have a score better than that of the best tree from
the previous generation has a probability p of of leaving an offspring by recombining with the
current best individual.

O KeePBEST — Each individual that does not have a score better than that of the best current
individual has a probability p of of leaving an offspring by recombining with the current best
individual.

="OPERATORAPPLIEDTO — IND is the default

O STEP - At each step of the heuristic, a single mutation operator is selected and applied to
each tree of each population.

O IND — Ateach step of the heuristic, each individual is separately assigned a mutation opera-
tor.

CP - Consensus pruning (MetaGA). This is the core of the "metaPopulation genetic Algorithm" (Lemmon
& Milinkovitch, PNAS 99:10516-10521 (2002)): P sets (populations) containing each / trees (individuals) are
forced to cooperate in the search for the optimal trees. At each step (generation) of the heuristic, individu-
als are mutated following inter-populations consensus rules. Death / survival of individuals is defined using
a selection scheme.

= CONSENSUS — STOCHASTIC is chosen by default

O STRICT — Any branch shared by all trees across all populations (100% consensus) will not be
mutated. Mutations on any other branch will be unconstrained.

O SrocHASTIC — Each branch (partition) common to at least two trees will be assigned a con-
sensus value. The probability of any mutation affecting that partition is 1-(consensus
value).Example: if a given branch is shared by 12 among 16 trees (e.g., 4 populations of 4 in-
dividuals each), any mutation affecting that branch will be accepted with a probability of 0.25.
A branch shared by all trees will never be mutated.

= OPERATOR — If operatoris set to Br.IND, @ mutation breaking a consensus won’t be applied and the
tree will remain unchanged until the next mutation (at generation i+1). If operator is set to SUPER-
vIsED, the operator will search for candidate mutations that don’t break any consensus. If no such
candidate exists, no mutation is performed and the tree will remain unchanged until the next gen-
eration.

= NPop - The number of populations (sets). Set to 4 by default.

= NIND — The number of individuals (trees) within each population (set). Set to 4 by default.

= TOLERANCE — The ConsENSUs command constrains how shared branches are modified. The TorLER-
ANCE parameter avoids partitions to become "frozen", i.e., inaccessible to mutations. The TOLERANCE
parameter helps avoiding to be trapped in a possible local optimum. Set to 0.5 by default.Example:
With "strict consensus" and a tolerance of 0.1, any branch shared by all trees is anyway mutated with
a probability of 0.1.

= HYBRIDIZATION — At each generation, there is a probability (between [0, 1] and set to 0.1 by de-
fault) that all sub-optimal individuals from one random population are not mutated but, instead, are
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recombined with one individual from another population; sub-optimal individuals from other popu-
lations experience the normal mutation procedure.
SELECTION — The method used to control death / survival of individuals :

O RaNk — We implement a rank selection similar to that described in (Lewis 1998, Mol. Biol.
Evol. 15, 277-283). The individual having the highest InL is automatically allowed to leave
k=0.25*N1InD offspring (i.e., copies of itself) in the next generation. Then, each individual is
assigned a probability p of leaving an offspring as a function of its position in a list in which
individuals are ranked by their score. The probability p for the ith individual of leaving an off-
spring to the next generation is equal to:

O TOURNAMENT — Two individuals are drawn randomly from the population of n individuals, and
one offspring is produced from the individual with higher score. Both trees are then placed
back into the mating population, and the whole process is repeated until n offspring have
been generated.

O REPLACEMENT — Two individuals are drawn randomly from the population of n individuals
and two copies of the better individual are returned to the mating pool (parents are dis-
carded). The process is repeated sn times, where s is the strength of the selection (1.0 by de-
fault), then the offspring population is generated as an exact copy of the post-selection par-
ent population.

O IMPROVE — Only those individuals that have scores better than that of the best tree from the
previous generation are kept. Each individual that fails this test is discarded and replaced by a
copy of the current best individual. This is the default selection method.

O KEEPBEST — Only the best individual of each population is kept, others are replaced by a
copy of it.

RECOMBINATION — Each counter-selected sub-optimal individual has a probability p (between [0, 1]
and set to 0.1 by default) to recombine with a better individual in the population. Recombination is
performed by exchanging subtrees defined by one of the identical taxa partitions in the two parental
trees (i.e., one internal branch that defines subtrees including the same taxa but with potentially
different sub-topologies). If no common branch exists, the offspring is defined as a copy of the best
individual. A recombination event can be viewed as a large number of simultaneous topological mu-
tations. The exact procedure depends on the selection scheme:

O Rank — Recombination is not available under that selection scheme.

O TourNaMENT — With a probability p, the offspring set after a tournament is not a copy the
individual with higher score but a recombination between the two trees that have been ini-
tially drawn for tournament.

O REPLACEMENT — With a probability p, only one (instead of two) copy of the better individual
is returned to the mating pool. The second individual returned is a recombination between
the two trees that have been initially drawn.

O IMPROVE — Each individual that does not have a score better than that of the best tree from
the previous generation has a probability p of of leaving an offspring by recombining with the
current best individual.

O KeepBEST — Each individual that does not have a score better than that of the best current
individual has a probability p of of leaving an offspring by recombining with the current best
individual.

NCorE — The number of cores/processors assigned for parallel processing. Different populations
will be assigned to different cores. Set to 1 by default (no parallelization). WARNING: this parameter
should be considered in combination with the ParaLLEL parameter (in REPLICATES). It is advised to
leave the NCorE parameter to 1 when you perform replicates with parallelization.
OPERATORAPPLIEDTO — IND isthe default

O STEP — At each step of the heuristic, a single mutation operator is selected and applied to
each tree of each population.

O Popr — At each step of the heuristic, each population is separately assigned a mutation opera-
tor (i.e., that operator is applied to all individuals within a population).

O IND — Ateach step of the heuristic, each individual is separately assigned a mutation opera-
tor.
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2. EVALUATION — By default, MetaPIGA evaluates trees with the maximum likelihood criterion using a single rate
matrix R for the TreE, the JC model and no rate heterogeneity. Note that if the dataset is partitioned with
charsets, some parameters (RATEPARAM, DISTSHAPE, PINV)can be overridden with the SPECIFICPARTPARAM
command for each partition.

RaTE — The rate matrix R (by default, MetaPIGA use one R for the TREE):
= BRANCH — NoT AVAILABLE YET — A different rate matrix R is used for each branch.
= TREE — A single rate matrix R is used across the whole tree.
DATATYPE=CODON — This token defines that nucleotides in this data set should be interpreted as codons. The
token has to be followed by the CopoNRANGE { first_position—last position} token, where ‘first_position’
and ‘last_position’ define the range of nucleotide indexes that will be interpreted as codons.
MopEL — Depending on the datatype (DNA or PROTEIN or STANDARD), the default substitution model is JC,
Po1ssoN, or GTR2, respectively. You can set substitution models with:
®= GTR - General-Time-Reversible model for nucleotides.
= HKY85 - Hasegewa-Kishimo-Yano 1985 model (nucleotides).
= TN93 - Tamura-Nei 1993 model (nucleotides).
= K2P - Kimura's 2 Parameter model (nucleotides).
= JC - Jukes Cantor 1969 model (nucleotides).
= GTR20 - General-Time-Reversible model for proteins.
®= WAG — Wheland and Goldman model (proteins).
= JTT - Jones-Taylor-Thornton model (proteins).
= DavHOFF — Dayhoff model (proteins).
= VT - Variable Time substitution matrix (proteins).
= BLOSUM62 —BLOSUMG62 (BLOcks of amino acid SUbstitution Matrix) substitution matrix (proteins).
= CPREV - Chloroplast reversible substitution model (proteins).
= MTREV - Reversible mitochondrial substitution model (proteins).
= RTREV — RtREV substitution matrix (proteins).
= MTMAM - Mtmam model (for mitochondrial data) (proteins).
= PoIssoN — Poisson model (proteins).
= GTR2 - General-Time-Reversible model for standard binary data.
= ECM - Empirical codon model for codon data.
®= GY - Goldman-Yang model for codon data.
RaTEPARAM — Set the values of each parameter of the rate matrix R.
= A | B| C | D | E- Thefive parameters that can be set with GTR. Set to 0.5 by default.
= K - The kappa parameter of K2P and HKY85. Set to 0.5 by default.
= K1 | K2 - The 2 parameters of TN93 (respectively K1 are transitions between purines, and K2
transitions between pyrimidines). Set to 0.5 by default.
= AR | AN | AD | .. | WY | WV | YV - The 189 parameters that can be set for GTR20. They
correspond to the upper right triangle of the GTR substitution matrix, with the 20 amino acids or-
dered by alphabetical order of their 3-letter names ARNDCQEGHILKMFPSTW Y V). For ex-
ample, A<->R rate is set using AR parameter (RA will not be recognized). Set to 0.5 by default.
AAFREQ — Used for empirical protein models with unequal equilibrium state frequencies (EMPIRICAL by
default).
= EMPIRICAL — Equilibrium amino-acid frequencies are fixed to the empirical values reflecting esti-
mates of the corresponding model.
= EsTiMATED — Equilibrium amino-acid frequencies are fixed to those observed in the dataset.
DISTRIBUTION — The rate heterogeneity (none by default).
= NonNE — No rate heterogeneity
= GaMMA — Rate heterogeneity following a Gamma distribution. The number of rate categories (4 by
default) and shape parameter alpha (default=1) can be defined.
DisTSHAPE - Shape parameter (alpha) of the gamma distribution. Set to 1.0 by default.
PINv — Proportion of invariable sites (between 0 and 1). Set to 0O (no invariant) by default.

3. SpecIFICPARTPARAM — Specific evaluation parameters can be set for each charset separately if the dataset is
partitioned. If no SPEcTFICPARTPARAM is defined for a given partition, parameters defined with the EvaruatIon
command will be used.
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e PaArRTNAME — The name of the partition to which the parameters apply. ATTENTION: the partition name
must always be defined before RaTEPaARAM, DISTSHAPE and PINV.
e RATEPARAM — Set the value of each parameter of the rate matrix R.

A | B | C | D | E- Thefive parameters that can be set with GTR. Set to 0.5 by default.

K - The kappa parameter of K2P and HKY85. Set to 0.5 by default.

K1 | K2 — The 2 parameters of TN93 (respectively K1 are transitions between purines, and K2
transitions between pyrimidines). Set to 0.5 by default.

AR | AN | AD | ... | WY | WV | YV - The 189 parameters that can be set for GTR20. They
correspond to the upper right triangle of the GTR substitution matrix, with the 20 amino acids or-
dered by alphabetical order of their 3-letter names ARNDCQEGHILKMFPSTW Y V). For ex-
ample, A<->R rate is set using AR parameter (RA will not be recognized). Set to 0.5 by default.

e DisTSHAPE — Shape parameter (alpha) of the gamma distribution. Set to 1.0 by default.
e PINV — Proportion of invariable sites (between 0 and 1). Set to 0 (no invariant) by default.

4. OpTiMIzATION — For configuring intra-step optimization frequencies, algorithm and targets. There are 5 ways of
choosing when MetaPIGA optimizes the tree during a heuristic. With NEVER, no optimization algorithm is applied.
With EnpSEARCH, final trees are optimized at the end of the heuristic. With ConsENsUSTREE, only the final con-
sensus tree built using all replicates is optimized (when perfomring single searches, i.e. one single replicate, no
consensus is built and no intra-step optimization of target parameters is performed). With STOCH (p), with p
between [0.01, 1], there is a probability p at each step to optimize the tree. With DISC (s), trees will be opti-
mized every s steps. Note that (1) with STOCH and DISC, optimization of the final trees is also performed at the
end of the heuristic (hence, at the end of each replicate if multiple replicates are performed) and (2) with Exp-
SEARCH, STOCH and DISC, the final consensus tree is also optimized when multiple replicates are
performed.You can also set :

e ALco - Set the algorithm used for intra-step optimization.

GA - Genetic algorithm. Simple GA without recombination: each tree to be optimized is copied 7
times and that population of 8 individuals is experiencing mutations (of targets, see below). Selec-
tion is performed with IMPROVE (see above). The GA is stopped when the likelihood remains un-
changed for 200 steps (generations).

PowWELL — NoT AVAILABLE YET — Direction set (Powell’s) method in multidimensions, using golden
section search to bracket a minimum of the likelihood function, and Brent’s method to isolate the
minimum.

DFO - NoT AVAILABLE YET — Derivative-Free Optimization. The method used is a trust-region
algorithm that employs interpolation models of degree at most 2 to build a model of the objective
function. The models are constructed using Newton fundamental polynomials.

e TARGET — Set the targets of the optimization procedure.

BL - Branch lengths.

R — Parameter(s) of the rate matrix R (not relevant with Jukes Cantor model).

GamMva — Shape parameter alpha of the gamma distribution (only relevant when rate heterogeneity
is used).

PINV — Proportion of invariable sites (only relevant when invariant sites are used).

APRATE — Among-Partition rate variation (relative branch lengths are only relevant when the data-
set is partitioned into charsets).

5. STARTINGTREE — Method used to generate the starting tree(s) for the heuristic. When using starting trees gen-
erated by NK or LNJ (see below), a model (and potentially rate heterogeneity distribution and proportion of in-
variable sites) must also be set for computing the distance matrix.

e GENERATION — By default, MetaPIGA uses Loose Neighbor Joining Trees (LNJ) as starting trees.

NJ - Starting trees are built using the Neighbor Joining method (Saitou & Nei 1987).

LNJ (range) —Loose Neighbor Joining. Range is a percentage value, that must be greater than 0
and smaller than 1. Starting trees have pseudo-random topologies based on the Neighbor Joining
algorithm. The classical NJ method joins 2 nodes having minimal rate-corrected distance. Here, un-
der LNJ, a list containing the (range x (NTax x NTax-1)/Z2) smallerdistances will be built
and two nodes will be randomly selected from it.Branch lengths are computed normally using the
Neighbor Joining method (Saitou & Nei 1987).1f the range parameter is close to 0, the LNJ tree will
be similar to the neighbor joining tree; if it’s close to 1, the tree will exhibit essentially a random to-
pology.
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6.

= RaNDOM — Starting trees have random topologies and random branch lengths. No distance matrix is
used, so you can’t choose a substitution model or rate distribution or proportion of invariable sites.
The random topology is generated by starting with a “root” node with three branches ending each
with an ‘open slot’. We know the list of available T taxa and we know that the number of internal
nodes in the final tree will be (T-2-root). The tree generator cycles through the list of open slots.
Each time an open slot is visited, there is a probability p=0.5 to fill the slot either with one of the
available taxa or with one of the available internal nodes (connected to two new branches, each
ending with an open slot). An internal node is always added if only one open slot remains. The algo-
rithm stops when all internal nodes and taxa have been incorporated. Branch lengths are drawn
from an exponential distribution (with A=1), and shifted by 0.001 (such that the minimum value is
0.001 and the mean is 1.001).
= GIvEN — User tree(s). If your Nexus file contains a TReE block (and the command G1ven is used), and
if you selected SA or HC as the heuristic option, the first tree in the tree block will be loaded and
used as starting tree. If you selected CP as the heuristic option with NPop populations, the NPop first
trees in the TrREE block will be loaded (one tree per population). If you selected GA as the heuristic
option, the NInD first trees in the TReE block will be loaded (one tree per individual). More options
for importing user starting trees are available in the GUI (see point 5.3.4. in the manual above).
MopEL — Depending on the datatype (DNA or PROTEIN or STANDARD), the default substitution model to
generate distance matrices is JC, PO1ssoN, or GTR2, respectively. You can set substitution models with :
= GTR - General-Time-Reversible model for nucleotides.
= HKY85 - Hasegewa-Kishimo-Yano 1985 model (nucleotides).
= TN93 - Tamura-Nei 1993 model (nucleotides).
= K2P - Kimura's 2 Parameter model (nucleotides).
= JC - Jukes Cantor 1969 model (nucleotides).
= GTR20 - General-Time-Reversible model for proteins.
= PoIssoN — Poisson model (proteins).
= GTR2 - General-Time-Reversible model for standard binary data.
®= NoNE - No distance matrix.
DISTRIBUTION — The rate heterogeneity (none by default)
= NoNE — No rate heterogeneity.
= GaMMA — Rate heterogeneity following a Gamma distribution. The number of rate categories is fixed
to 4 but the shape parameter alpha (default=0.5) can be defined.
PINv — Proportion of invariable sites (between 0 and 1). Set to 0 (no invariant) by default. If PIxv > 0, the
total number of sites is adjusted to have distances equal to the mean number of substitutions over variable
sites only.
P1 — Base composition of invariant sites (used only if PInv > 0).
= EQuaL — The invariant sites will have base composition equal to 0.25.
= ESTIMATED — The invariant sites base composition is set to the average base composition across all
sequences.
= ConNsTANT — (Default) The invariant sites base composition is set to the average base composition of
the site which are constant.

OPERATORS — Sets the operators used to generate new solution trees. You can list more than one operator, and
some can have specific parameters.
e SELECTION This keyword can be set to:

"= ORDERED - Selected operators are chosen one after another.
= RanpoM — (Default) Selected operators are randomly drawn.
m FRrReEQLIST - Selected operators are drawn following probabilities defined in FrREQUENCIES.
If OPERATORS parameter is not set, MetaPIGA uses the following operators by default: NNI, BLMINT,
TXS (2), STS(2). Available operators are:
" NNI (NEAREST-NEIGHBOR INTERCHANGE) — Two grand-children branches of a random internal
node are swapped.
"= SPR (SUBTREE PRUNING AND REGRAFTING) — Removes a branch from the tree with a subtree at-
tached to it and re-grafts the subtree elsewhere.
= TBR (TREE-BISECTION-RECONNECTION)— Breaks a branch and reconnects each of the two sub-
trees on a random branch.
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TXS (TaXa Swapr) — Swaps a given number of randomly-chosen leaves (defined between paren-
theses). The value for this operator is a number between 2 and the number of leaves. You can also
set the parameter to AL (swap all leaves) or RanpoM (swap a random number of leaves). If you set a
number smaller than 2, 2 leaves will be permuted. If you set a number greater than the number of
leaves, ALL leaves will be permuted. Default parameter is 2.

STS (SUBTREE SwaP) — By default, swaps two randomly-chosen internal nodes (i.e., subtrees
that contain more than one leaf). If the parameter is set to Ranpom instead of 2, the whole tree will
be divided into a random number of subtrees, and all of them will be permuted.

BLM (BraANCH LENGTH MUTATION) — Randomly changes the length of a randomly-chosen branch
by multiplying the parameter’s value of the previous generation by a random number drawn from an
exponential distribution (with A=2), and shifted by 0.5 (such that the minimum value is 0.5 and the
mean is 1).

BLMINT (BRANCH LENGTH MUTATION ONLY ON INTERNAL BRANCHES) — Randomly changes the
length or a randomly-chosen internal branch by multiplying the parameter’s value of the previous
generation by a random number drawn from an exponential distribution (with A=2), and shifted by
0.5 (such that the minimum value is 0.5 and the mean is 1).

RPM (RATE PARAMETERS MUTATION) - Randomly changes the R matrix values by multiplying the
value of the previous generation by a random number drawn from an exponential distribution (with
A=2), and shifted by 0.5 (such that the minimum value is 0.5 and the mean is 1). Parameter for this
operator is the number of R elements to change (1 or ALL).

GDM (GaMMA DISTRIBUTION MUTATION) — Randomly changes the alpha parameter of the Gamma
distribution by multiplying the parameter’s value of the previous generation by a random number
drawn from an exponential distribution (with A=2), and shifted by 0.5 (such that the minimum value
is 0.5 and the mean is 1). Only available when gamma-distribution rate heterogeneity has been se-
lected.

PIM (PROPORTION OF INVARIANT MUTATION) — Randomly changes the proportion of invariables
sites by multiplying the parameter’s value of the previous generation by a random number drawn
from a normal distribution (with mean=1 and SD= 0.5). The resulting multiplier is rejected if <
0.4.0Only available when proportion of invariable sites has been selected.

APRM (AMONG—PARTITION RATE MUTATION) - Randomly changes the among-partition rates for
relative branch lengths by multiplying the parameter’s value of the previous generation by a random
number drawn from a normal distribution (with mean=1 and SD= 0.5). The resulting multiplier is re-
jected if < 0.4.0nly available when the dataset is partitioned with “charsets”.

FREQUENCIES — Used to set the frequencies of operators, using operator (frequency) .
DyNaMICFREQ — Operators set to dynamic have their probabilities of use automatically adjusted at every ‘inter-
val' to reflect their relative contributions to score improvements (the probability of using a specific operator is
increased or decreased, if its contribution to the score improvement is increased or decreased, respectively).You
can set some parameters for dynamic frequencies:

o DYNOPERATORS — The list of operators is set to dynamic.

e DINT - Interval (in number of steps) used to recompute the frequencies. Set to 100 by default.

e DMiN - Frequencies can't be decreased under the lower bond . Set to 0.04 by default.
SETTINGS — Some miscellaneous MetaPIGA settings

e REMOVECOL — Set to None by default, treating gaps ('-') as N (A or C or T or G) in nucleotide datasets, or as
X (any amino acid) in protein datasets, or as ? (0 or 1) in standard datasets. Can be set either to Gap, for
removing every column containing a gap ('-'), or to NGap for removing every column containing a gap or a
N/X/? in nucletotide/protein/standard datasets.
Dir — Defines the whole path where the Results folder will be placed. By default, results folders are put in a
‘MetaPIGA results’ folder in your home directory (e.g. ‘My documents’ in Windows). If you use the Dir
command in a Nexus file, you MUST put the folder name between quotes.
LaBeL — Defines the name of the Results folder for output files. Changing the label changes the Results
folder name but not the nexus file name. The Results folder will be placed into the directory defined with
the DIr command. The Result folder is named with its label followed by the date (year-month-day) and
followed by the time (hour_min_sec) at the which the search was started. This allows for easy differentia-
tion of results performed at different times on the same dataset. If you use the Lager, command in a Nexus
file, you MUST put the label name between quotes.
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® GRID — NOT AVAILABLE YET — MetaPIGA will run through a GRID using the XtremWeb-CH middleware
(see http://www.xtremwebch.net/). You must specify the server address (e.g.
SERVER=HTTP: / /ADDRESS : 8080), your identifier on the GRID (CLiENT command) and the identifier of the
MetaPIGA module on the GRID (MopuLE command). Note that when MetaPIGA runs on a GRID, it does not
generate any log file (Lo command is ignored). GRID running is disabled by default.

10. ourGroup - Sets any number of taxa that will form the outgroup (all other taxa are in the ingroup). Operators
will never mix up taxa between the outgroup and the ingroup. The tree is rooted between outgroup and ingroup.

11. DELETE - Sets any number of taxa that will be removed from the analysis.

12. cuarser - Defines a charset ; you must use a different CHarsET command for each charset to be defined. For
each one, you must give its Name and a list of character positions with SET. For defining a range of character po-
sitions, you can use 2 positions separated by ‘-* (like 60-125), and potentially add ‘/’ and the interval size. For
example 60-125/3 will take positions 60, 63, 66, 69, 72, .., 120, 123. Charsets can be defined as
the combination of other charsets (defined higher in the METAPIGA block) or by the combination of charset(s)
and character list.

13. ExcrLupe - Sets any number of charsets that will be excluded from the analysis. A charset is defined by 2 charac-
ter positions (like 60-125), or can be defined with the CHaARSET command.

14. parTITION - Divides the data matrix in charsets and compute likelihood separately for each charset. A charset
is defined by 2 character positions (like 60-125), or can be defined with the CHARSET command.

15. srtopAFTER - Sets the stop criterion of the heuristic. Any number of conditions can be set and each one can be
necessary or sufficient. The heuristic stops when any of the sufficient conditions is met or when all necessary
conditions are met. Conditions are sufficient by default and can be switch to necessary using the NECESSARY
command. If STop AFTER is not set, the heuristic will not start but starting tree(s) will be generated.

e STeEPs — Defines a maximum number of generations.

e TiME — Allows to stop the heuristic after a given amount of time (in hours).

e AuTo — AUTO will stop the heuristic if the best solution evaluation doesn’t improve more than a given per-
centage (AUTOTHRESHOLD parameter, set to 0.0001 by default, i.e. 0.01%) at any step during the defined
number of steps.

e CONSENSUS — CONSENSUS can only be used with Consensus Pruning (metaGA heuristic), and will stop the
heuristic when the mean relative error among consensus trees (INTERVAL parameter, set to 10 by default)
remains below a given value (set with MRE parameter, 0.03 by default). Each consensus tree is built using all
trees from all populations in a generation. As consensus trees tend not to vary much between 2 consecutive
generations, the user is advised to allow several generations between sampling (with GENERATION parame-
ter, set to 5 by default).

e NeceEssAarRY — The following conditions can be switched to necessary : STEPs, TIME, AUTO, CONSENSUS.

16. RePLICATES — The number of times the metaheuristic will be repeated with the same dataset. At the end, a
majority-rule consensus tree is produced. By default, only one tree is produced.

e AuroSTOP — Adds a stop condition to replicates’ generation.

= NonNE - By default, there is no stop condition, so a given number of replicates is produced. You can
set the number of replicates produced with RNuM parameter.

" MRE (error) - Thisoption allows MetaPIGA to stop producing replicates when the Mean Relative
Error among consecutive consensus trees remains below a given value. Erroris a value between
[0,1] set to 0.05 by default.

O RMIN — The minimum number of replicates to produce. Default value is 100.

O RMax — The maximum number of replicates to produce. Default value is 10 000.

O INTERVAL — The number of consecutive consensus trees (set to 10 by default) that must
have a MRE below a given value before stopping the production of replicates .

e PaARALLEL — The number of replicates to be run in parallel (i.e., simultaneously). By default, this parameter
is set to 1 (no parallel processing). WARNING: It is strongly advised not to use a value greater than the
number of processors/cores available on the running computer. WARNING2: this parameter must be con-
sidered in combination with the parameter NCore (i.e., the number of cores/processors assigned for paral-
lel processing WITHIN a replicate). For example, if you use a computer with 4 cores, set the NCore parame-
ter to 1 and the PArRALLEL parameter to 4, such that each replicate will use a single core (i.e., 4 replicates
will be run simultaneously). If you use a computer with 8 cores, you can set the NCore parameter to 2 and

MetaPIGA 3.0 manual ‘!{—' “p5i


http://www.xtremwebch.net
http://www.xtremwebch.net
http://address:8080
http://address:8080

the PARALLEL parameter to 4, such that each replicate will use two cores AND 4 replicates will be run simul-
taneously.

17. Loc - Set the log files you want as output. They can give you valuable information on what happens during the
execution of MetaPIGA. Be aware that selecting the log files indicated with asterisks can (i) significantly slow
down the search and (ii) fill up large amount of disk space (with the magnitude of slow-down / fill-up approxi-
mately indicated by the number of asterisks). All log files are written in the results folder.

DaTa - Working matrix log file - Prints the compressed dataset to '‘Dataset.log'. The last row contains the
weight of each column, i.e., the number of times this data pattern is found in the data matrix. .

DisT — Distance matrix log file - Prints the distance matrix to 'Distances.log’.

TREESTART — Starting Trees log file - Prints the starting tree(s) to 'StartingTrees.tre'.

HEUR (*) — Heuristic search log file - The 'Heuristic.log' file records details about each step of the heuris-
tic used. It requires disk space between 500 bytes and 1 Kb per iteration of the heuristic.

TREEHEUR (**) - Heuristic search tree file - 'The 'Heuristic.tre’ file records each tree found at each step
of the heuristic. It requires disk space of +/- 130 bytes per taxa per tree recorded. For example, recording
trees for a dataset of 200 taxa, using the metaGA heuristic with 4 populations of 4 individuals each, for a
fixed amount of 5000 generations will generate a file of about 1.5Gb for each replicate produced.
CoNseENSUS (**) —Consensus log file - The ‘Consensus.log’ file records consensus at each step of Consen-
sus Pruning. It requires disk space between 100 bytes and 1Kb per taxa and per consensus recorded. For
example, recording consensus for a dataset of 200 taxa, using the metaGA heuristic for a fixed number of
5000 generations will generate a file between 100Mb and 1Gb for each replicate produced..

OPDETAILS (***) — Operators log file - The 'OperatorsDetails.log' file records details about the opera-
tors used. It requires disk space of 200-300 bytes per taxa per operation. For example, recording operator
details for a dataset of 200 taxa, using the metaGA heuristic with 4 populations of 4 individuals each, for a
fixed number of 5000 generations will generate a file between 1.7Gb and 3.4Gb for each replicate pro-
duced.

OrSTATS — Operator statistics file — The ‘OperatorsStatistics.log’ file records operator statistics at the end
of a search, as well as each time the operator frequencies have been updated.

ANCSEQ (*) - Ancestral sequences log file - At the end of the heuristic, the ancestral sequence probabili-
ties of each internal node are printed into the 'AncestralSequences.log' file.

PERF (*) - The ‘Performances.log’ file records the amount of time (in nanoseconds) used by each op-
erator. It requires disk space of +/- 1 Kb per iteration of the heuristic.
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8. Appendix 2: Using the Stochastic Simulated Annealing (SSA)

Select the ‘Simulated Annealing’ radio button in the ‘Heuristic’ window to see all available parame-
ters (Fig. 31). We implemented 14 highly-parametrized cooling schedules in MetaPIGA, including
the ‘Lundy’ cooling schedule [26, 43]. The user can control all cooling schedule parameters: the
starting temperature computation method, the maximum acceptance probability, the temperature
decrease frequency, and the possibility of ‘reheating’. Changing the cooling schedule in the ‘Heu-
ristic’ window will change the set of available parameters. Note that several of these cooling sched-
ules are quite similar to each others such that we might reduce the number of available schedules in
future versions of MetaPIGA.

(&) (@) Analysis settings

[ Heuristic Evaluation criterion Starting tree(s) Operators Miscellaneous |

O Hill Climbing () Genetic Algorithm

{*) Simulated Annealing () Consensus Pruning (metaGA)

Cooling Schedule Temperature decrement Cooling schedule preview
® Lundy Transcendental O After 2! steps
() Ratio-Percent O Exponential @ After 10 successes
0.99 () Logarithmic or 100 failures
() Fast Cauchy () Periodic .
- Reheating
() Boltzmann () Smoothed periodic
) . Never
) Geometric _ ® After 300 decrements
I~ Hyperbolic of temperature
( Linear () Tangent () When temperature reach
O Triangular () Cosinus 0.001 % of

. starting temperature
() Polynomial

Lundy beta parameters Estimation of dL
c= 0.5 [%] ® Burn-in period

’ 1(4) QO 0.1 % of
alpha = 0.5 1,

Neighbor Joining Tree

Fig. 31: The ‘Heuristic’ window with ‘Simulated annealing’ selected and the ‘Lundy schedule’ settings.

In each of the 14 available cooling schedules, 7; is the temperature after i decrements, and I is the
maximum number of temperature decrements before reinitialization to 7 (the starting temperature).
Except for the ‘Lundy schedule’, Ty (and Tr when relevant) is computed as follows:

—AL
InA,

where AL is the upper limit of likelihood change, whereas Ap and Ar are, respectively, the initial
and final ‘maximal acceptance parameter’, i.e., the maximal probability to accept a tree with a
worse likelihood. Hence, Ap and Ar define the initial and final temperature values, and the cooling
schedule defines how the temperature is decreased between these two values. The various cooling
schedules (and corresponding curve equations of temperature change) are listed below, with Ap and
Ar defined by the user. The cooling schedule requires defining the number of iterations (i.e., the
number of times operators have been used to generate a change in the tree) after which a tempera-
ture decrement is performed. The user can choose either (i) the number of iterations (steps) or (ii)
the number of successes (generating better trees) or failures (not generating better trees) required
before a temperature decrement is performed. As decreasing the temperature translates into reject-
ing more easily trees with lower likelihoods, a reheating parameter allows defining when the tem-

—AL
InA;

TO = and Tl— =
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perature is reinitialized to 7o to facilitate crossing of valleys in likelihood space. Finally, the method
for defining AL (required for computing the initial and final temperatures) is also chosen by the user
either as the percentage of the Likelihood of the Neighbor-Joining tree or as an estimate generated
by burn-in. In the latter case, each mutation operator is applied 20 times on the starting tree and the
maximum difference of likelihood observed is used as AL. The table below shows the cooling
schedules implemented in metaPIGA.

Cooling schedule

Corresponding curve equation

curve

Lundy

(with c and a as
user-defined pa-
rameters)

Cc

with = "I NIT

(I-ayn+o ™

B is the cooling rate (its value is < 1) and is computed using parameters
from the dataset: n is the number of sequences, m is the number of
aligned columns, ¢ and a have values between 0 and 1, and [nNJ

is the log likelihood of the neighbour-joining tree.

T =
“1+ip

Ratio-Percent

i1 = 6T, with o<1
(with parameter &)
T
Fast Cauchy T = 70
T
Boltzmann T = _0
Ini
Geometric A
T, =Ty with a<1
(with parameter et)
. (T, -T.)
Linear T,=T,—i Or r
T i/T
Triangul T =T, =2
riangular o [Tr J
Polynomial T T+ 4T — (T, T )T +1)

" CGi+1) 0 r
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Transcendental

- smoothed peri-
odic

. T =T,
- exponential r 1+e3(i—§>
Transcendental _(%]2 In ;o
- logarithmic T, =T,e r
Transcendental _ (T, -T) l+cosim |+
- periodic r
Transcendental

Hyperbolic — (T, —Tv) 1— tanh(& -5)|+T,
- tangent T :
Hyperbolic _ (T, - Tv) "

- cosinus cosh’®@ "

MetaPIGA 3.0 manual ‘!w " p55



9. Appendix 3: A simple introduction to ML phylogeny inference
9.1. Introduction

The Maximum Likelihood approach to phylogeny inference is based on the use of a substitu-
tion model that allows computing the likelihood of a tree, i.e., the probability that its topology and
branch lengths (given the model parameters, such as instantaneous substitution rates, state frequen-
cies, gamma distribution of rates, etc) yielded the observed data. Substitution models used in the
field of phylogeny inference are Markovian: the conditional probability distribution of future states
depends only upon the present state, i.e., the probability of change of a character from state i to state
J does not depend on the history of the character before state i. We also assume that the Markov
process 1s homogeneous (i.e., the instantaneous substitution probabilities are identical everywhere
in the tree) and time-reversible (the substitution rate i — j is identical to the substitution rate j — i).
Given time reversibility, the likelihood of a tree does not depend on where that tree is rooted. In
other words, trees are unrooted and the choice of outgroup taxa (orienting the tree in time) is an as-
sumption performed by the user. Finally, we assume that different characters (i.e., different posi-
tions in the multiple alignment) evolve independently, such that the likelihood of every character
can be computed separately.

9.2. The General-Time-Reversible (GTR) Model

The easiest way to represent a model is by using a matrix @ in which each element Qj; is the
instantaneous substitution rate from state i to state j. We use here the example of a 4x4 matrix for
nucleotide substitutions, but the concept is the same for amino-acid substitutions or codon substitu-
tions (but the corresponding matrices are then 20x20 and 64x64, respectively).

—(uar, + ubw; + Ucrw,) uar, ubr,, e,
0= Hgm, —(ugm, + udng + per;) udrg, Herty
phr, pire —(Uhm, + pim, + i) wfm,

ujm, Mk, uimg, —(ujr, + pkme + pims)

where 71; is the equilibrium frequency of state i, and u is the mean instantaneous substitution rate.
The latter is modified with relative rate parameters a, b, ..., [ specific to each possible substitution.
However, as indicated above, we use time-reversible models, such that a=g, b=h, c=j, d=i, e=k, and
J=L. The diagonal elements of the matrix make the sum of each line equal to zero.

The instantaneous substitution rate matrix Q can be decomposed into a rate matrix R and an equilib-
rium frequency matrix IT:

O=RXII Equation 2

where
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The mean instantaneous substitution rate can be computed as follows:

1 .
U= Cicre Equation 5
)y w9
where
- am. bm; cm,

0= ar, dr; em; Equation 6

br, dr. - frm,

e, em. [fm; —

9.3. Computing the likelihood of a tree

The principle for estimating the likelihood of a tree is based on computing the probability of a
substitution from state i to state j (with i and j possibly identical) given the length v, of the branch x.
Given that a nucleotide in a sequence can experience multiple substitutions through time, the prob-
ability of observing a substitution between two nodes is not a linear function of the branch length v,
but takes the form:

pt)=e”

Equation 7

where A and 7 are the substitution rate and the time, respectively. Note that it is not possible to sepa-
rate A and ¢ because a branch can be long due to a long time and/or a large rate. In other words, the
branch length is Az.

When considering the GTR model, the equation takes the form

p(t)=e”

Equation 8
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Where Q is the instantaneous substitution matrix (equation 1). The equation can be computed by
using the eigenvectors and eigenvalues of the matrix.

Partitions are incorporated in the computation by multiplying # (in Equation 8) by ©,, i.e., the rela-
tive rate of partition p. Relative rates of partitions are optimized separately but each partition is
weighted according to its size (S(p)), and the weighted average of among-partitions rates is con-
strained to 1, i.e.,

nPar

2 S(poO,=1 Equation 9
14

Let’s take a simple example. If the observed sequence data, and the tree to evaluate, are respec-
tively:

Taxon 1 ACCGTCATCAGG
Taxon_ 2 GCTATCGCCAGC
Taxon_3 ACCGTTATCAGG
Taxon 4 GCTGTCGTCAGG

the likelihood of that tree is the probability to generate the observed data given the substitution
model. The process is performed separately for each position (each column in the alignment). Let’s
consider the first position (underlined in the sequence alignment above). The states at the internal
nodes X and Y are unknown. Imagine that both X and Y were of state A. Given that Taxa 1 and 3 ex-
hibit a A, and that Taxa 2 and 4 exhibit a G, the full probability of observing the first position given
the tree is the Probability to:

observe no change between Y(=A) and Taxon_1(=A) given branch length v,

AND observe no change between Y(=A) and Taxon_3(=A) given branch length v;
AND observe a change from X(=A) to Taxon_2(=G) given branch length v

AND observe a change from X(=A) to Taxon_4(=G) given branch length v4
AND observe no change from X(=A) to Y(=A) given branch length vs

In probabilistic terms, the full probability of observing states A, G, A, and G for, respectively, the
sequences 1,2, 3, and 4, GIVEN that the internal nodes X and Y exhibit the state A is:

h(A,G,A,G |X:A,Y:A) = PAA(V]) . PAA(V3) . PAG(VZ) . PAG(V4) . PAA(V5) Equation 10

However, we don’t know the unobserved states of the internal nodes, such that the combination
considered above (X=Y=A) is only one possibility. Hence, we have to consider each possible com-
bination of states. In the simple tree above, there are only 2 internal nodes and 16 possibilities:
X=Aand Y=A combination 1

X=Aand Y=G  combination 2

X=Aand Y=C combination 3

X=T and Y=T combination 16
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Hence, the full probability of generating the first position in the alignment above (i.e., states A, G,
A, and G for, respectively, the sequences 1, 2, 3, and 4) is the sum of the probabilities of combina-
tions 1 to 16. In other words, the real (unobserved) states of the internal nodes corresponded to
combination 1 or combination 2 .... or combination 16. In probabilistic terms, we therefore need to
compute:

Prob(combination 1) + Prob(combination 2) + ... + Prob(combination 16) Equation 11
where “Prob(combination 1)” is equation 10.

To generalize, the likelihood of observing the first position of the alignment above given the follow-
ing tree

. .
. .
. .
.
'
.
.
.
.
.
.
.
.
.

is (equation 12):

h(A,G,A,G) = gxPxG(V 1) Pxc(v 2)@%(1} 5)Pya(v1) Pya(v3)

Note the parameter g, in equation 12, which is the equilibrium frequency of state x.

Finally, the likelihood of the tree given the full alignment is
L= HLI. Equation 13
where L; is the likelihood of position i.

To avoid the manipulation of exceedingly small values, it is much more convenient to compute the
log likelihood of a tree as follows:

InL= ZIn L Equation 14

Much additional information can be found in the references given in the ‘Background’ Section
(Section 2) of this manual.
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